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1 Safety instructions
The purchased software has been programmed according to the state of the art
and recognised rules. Nevertheless, damage such as loss of data or malfunction of
connected devices may occur during use. Further information can be found in the
EULA.
If parameterisations are carried out by means of the software, the user assumes li-
ability for the controlled components. Incorrect parameterisation can impair the
function of the drive controller or the machine or put it out of operation completely.

 CAUTION Inputs have immediate effects on the connected unit!
a) Test inputs without motor.
b) Check the result of batch files.
c) Do not connect the motor until all tests have been successful.

Failure to comply with the safety instructions will result in the loss of all claims
against the manufacturer caused by thereby.
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2 Properties
• Based on the CODESYS platform and the .NET framework
• Program error and message history
• Commissioning Wizards
• Integrated KEB document database
• Integrated device configurator
• Integrated determination of the energy efficiency of KEB COMBIVERT
• Integrated Safety Editor for safe communication with the KEB safety modules
• 16-channel oscilloscope
• Communication via UDP/IP or DIN 66019II (serial or USB) Protocol
• IP addressing of several devices
• Automatic recognition of USB converters
• Parallel search on multiple serial ports and UDP/IP
• HSP5 protocol indirectly via KEB USB serial converter or KEB port expander
• Update function via internet
• It can be installed and operated in parallel with COMBIVIS 5 but no simultaneous ac-

cess to the same COM port
• Support for COMBIVERT type F5/ B6/ G6/ F6/ H6/ F6/ P6/ S6/ T6, COMBICONTROL

C6 and Stepper/BLDC
• Older devices such as COMBIVERT 51 to 58 / F0 to F4 are not supported!
• No display of operator parameter menu with Devicenet and early Interbus and CAN op-

erators type F5 (separate operator menu at CV 5)
• Several versions can be installed in parallel.

Detailed information can be found in the "Release Info" under menu "Help" → "Show Re-
lease Notes".

2.1 Changes in version 6.8.0
• (≡► Communication settings [} 109]) - Semi-automatic baud rate setting and reset to

default value.
• (≡► Renaming elements [} 70]).
• Download extension packages
• CAN Cross functionality
• Warning message for test run can be set
• Test run wizard is opened in a separate window and placed in the Wizards folder.
• Tooltips extended
• Extension of Motorwizard with Z2 sine filter
• Moving scopes in the Navigator possible
• Timeout values of the communication settings changed
• Silent installation/uninstallation inserted
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3 Versions
The free COMBIVIS installation file consists of 2 modules:
Selecting the programme module opens the respective module version.

Fig. 1: Icon 6_8

Parameterisation version "COMBIVIS 6" (dealt with here)
• Parameterisation and analysis of KEB COMBIVERT
• Energy efficiency calculation
• Document database (subject to registration)
• Without term limit
and the

Programming version "COMBIVIS studio 6"
additionally:
• PLC programming according to IEC 61131-3 (C6 controllers)
• Bus configuration (e.g.: EtherCAT, CAN, Profinet)
• Configuration of remote I/Os
• Other additional components
• Licensing with costs required
• In the free demo version time-limited (1h) and no boot projects.

Both modules can be started via the desktop icons or the start menu.

Fig. 2: Icons_Start bar

Optional:
Visualisation platform "COMBIVIS studio HMI"
• Editor with full SCADA  functionality
• Extensive graphics library and toolbox with ready-made controls
• Easy data exchange with COMBIVIS studio 6 projects
• Licensing with costs required
• Free demo version, time-limited
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Remote maintenance with "COMBIVIS connect"
• Monitoring, project update and maintenance via "end-to-end" VPN
• Enables direct, worldwide support of KEB devices
• Control Center free of charge
• Requires one-time licensing of a company domain

For further information on modules not covered here, please contact KEB.
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4 System requirements
COMBIVIS 6 and COMBIVIS studio 6 are intended for use on Windows
desktop systems. Other systems such as Windows Embedded, Windows
IoT or Windows Server are not supported.

The COMBIVIS studio 6 Safety Editor is no longer included in COMBIVIS studio 6.8.0.

4.1 Minimum equipment for smaller projects
• Microsoft Windows 11 or Windows 10, 32-bit or 64-bit version
• 2 GHz processor
• 4 GB RAM (8 GB recommended)
• 10 GB free hard disk space
• Screen resolution min. 1024 x 768
• Display 100% or 125% (150% with restrictions)
• Microsoft .NET Framework Version 4.8
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5 Version information
The version info is displayed under menu bar "Help" → "Information

1 2
Fig. 3: Version info

1 Version of COMBIVIS 6 2 Version of the underlying CODESYS
software
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6 Online Tutorials
KEB offers information and tutorials on the KEB YOUTUBE channel.

Information, applications, technology:

Here you can find more online tutorials from KEB.

(► https://www.youtube.com/channel/UCf577xwEcis-
zTqrSAUCVXw)

Tutorials:

Here you can find more online tutorials from KEB.

(► https://www.youtube.com/playlist?list=PLWebeb-
k4oOl_UOXashjFA58aE1bHToOM-)

https://www.youtube.com/channel/UCf577xwEcis-zTqrSAUCVXw
https://www.youtube.com/channel/UCf577xwEcis-zTqrSAUCVXw
https://www.youtube.com/playlist?list=PLWebebk4oOl_UOXashjFA58aE1bHToOM-
https://www.youtube.com/playlist?list=PLWebebk4oOl_UOXashjFA58aE1bHToOM-
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7 Accessories

7.1 DIN 66019 - RS-232 cable operator 0058025-001D

0058025-001D
1

5

6

9 1

5

6

9

Fig. 4: Cable RS232 PC-inverter

2
3
5

2
3
7

PC
D-Sub DE-9 (F)

Drive Controller
D-Sub DE-9 (M)

Fig. 5: Wiring diagram

7.2 KEB USB serial converter 0058060-0040
Converts USB to serial DIN66019 II and HSP5 D-SUB 9-pin

Fig. 6: KEB USB serial converter 0058060-0040

• The KEB-USB serial converter represents a virtual COM interface.
• It is not a commercially available USB-serial converter, as the serial protocol is not fully

translated!
• DIN66019 II is always used on the USB side.
• Several USB-serial converters with one KEB device each can be operated simultan-

eously.
• Internal potential separation.
• Does not require an external power supply.
• The 9-pin serial side supports with automatic detection:
• DIN66019 II based on RS 232.
• HSP5 (TTL level).
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• 38.4 kBaud should be used as the baud rate.
• Max. baud rate is 115.2 kBaud.
• No automatic baud rate adjustment is supported.
• The baud rate can be set via COMBIVIS 6.

File Transport Programme FTP / Device Memory
As of version V2.4, the copying of recipes per (≡► FTP program [} 321]) or Wizard to the
COMBIVERT F6/S6 is supported.
The KEB-USB converter is then labelled "FTP ready".

Fig. 7: Execution File Transport Program FTP

Driver installation
The driver is installed during the installation of COMBIVIS 6. If not desired, this can be
prevented during setup by unchecking the box:

Fig. 8: Execution Setup COMBIVIS 6 Select Additional Tasks

The signed USB driver "kebcdc.inf" is located in the COMBIVIS 6 installation directory "C:
\Programmes(x86)\KEB\COMBIVIS_6\Drivers".
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With some versions of Windows, a driver from STMicroelectronic is installed automatic-
ally. This can also be used. However, the KEB USB converter is then not named as a
KEB device in the control panel. The KEB driver would then have to be installed manually
via the Windows device manager "Update driver".

The KEB-USB serial converter Art. No. 0058060-0020, which is no longer manufactured,
has the same properties, but no electrical isolation. Due to data transport problems, this
should not be used on COMBIVERT F6/S6.

Please note for COMBIVERT F5 and B6 on HSP5 interface:
Since node addresses are not specified for HSP5 connection of the USB-serial converter,
COMBIVIS 6 finds a device on every device address searched!
e.g. when searching on addr. 0 and 1, the same unit is found and inserted twice, regard-
less of which actual unit address is set.
Therefore, when connecting via HSP5 interface, search only on one address!

Fig. 9: Connection F5 and B6 on HSP5

Under "Connect to device", uncheck "Automatically detect nodes", otherwise the device
will be included in the project up to 240 times! Typically, node address 1 is used.
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Fig. 10: Automatically detect node address

7.3 HSP5 adapter 00F50C0-0020

Connection to COMBIVERT B6 and F5 bus operators (HSP5 protocol) only with KEB
USB serial converter or port expander.



Accessories | 7

ma_mu_sw-cv68-20428970_en 33

Fig. 11: Adapter D-SUB9 / RJ45_00F50C0-0020

7.4 Port Expander 00F5025-0080
Ethernet / USB - HSP5 converter
Part no. 00F5025-0080
The Port Expander is a communication gateway with Ethernet and USB interface and 4
HSP5/485 interfaces for connection to drive controllers or operators KEB COMBIVERT.
With the Port Expander, up to 4 units with HSP5 interface can be addressed with
COMBIVIS 6, as the Port Expander can convert the HSP5 protocol into DIN66019. Oper-
ation with COMBIVIS 5 is also possible.

Connection options in detail:
Input side:
USB on the USB-B interface
Ethernet:
• ARP Address Resolution Protocol Response
• ICMP Echo Response (Ping)
• TCP/IP DIN66019II, Modbus/TCP, Http
• TCP/UDP DIN66019II, Modbus/TCP
• DHCP BootP Response, can be switched off

Output side:
One HSP5 device (F5 control card (X4A) direct / F5 bus operator / B6) at each of the 4
output interfaces.
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At port 4 (X4D), an RS485 bus with DIN66019II can alternatively be set, thus theoretically
up to 235 participants with a serial DIN 66019II interface (F5 interface operator / G6 / H6 /
P6 / F6 / S6).
The power supply is provided by an external 24V power supply unit or via the USB
cable.
The Port Expander can be mounted on a mounting rail in the control cabinet or operated
locally on the table.

Part number:

Part number: Name Properties
00F5025-1080 PORT EXPANDER SET with USB A-B, cable -4025 and HSP5 adapter - 0020
00F5025-0080 PORT EXPANDER USB, Ethernet-, 4x HSP5 interface, ext. 24V
00F50C4-1010 USB cable USB A-B, 4 pole, l = 1 m
00F50C0-4010 Cable RS 485/ HSP5 Connection RJ 45 - D-SUB 9, l = 1 m
00F50C0-4020 Cable RS 485/ HSP5 Connection RJ 45 - D-SUB 9, l = 2 m
00F50C0-4025 Cable RS 485/ HSP5 Connection RJ 45 - D-SUB 9, l = 2.5 m
00F50C0-4050 Cable RS 485/ HSP5 Connection RJ 45 - D-SUB 9, l = 5 m
00F50C0-0020 Fieldbus Adapter HSP5 D-SUB 9 / Western 400 mm
00F50C0-0021 Cable RS 485/ DIN 66019II Connection RJ 45 - D-SUB 9, l = 2.5 m

The inexpensive starter set - part no. 00F5025-1080 - contains:

Part number: Name Properties
1x 00F5025-0080 PORT EXPANDER USB, Ethernet-, 4x HSP5 interface, ext. 24V
1x 00F50C4-1010 USB cable USB A-B, 4 pole, l = 1 m
1x 00F50C0-4025 Cable RS 485/ HSP5 Connection RJ 45 - D-SUB 9, l = 2.5 m
1x 00F50C0-0020 Fieldbus Adapter HSP 5 D-SUB 9 / Western 400 mm
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Fig. 12: Port Expander Bundle 00F5025-0080

Circuit example with COMBIVERT G6 and F5:

1

234

Fig. 13: Circuit example COMBIVERT G6/F5

1 Fieldbus adapter HSP5 Part No.
00F50C0-0020

2 Cable HSP5 Part No. 00F50C0-4025



7 | Accessories KEB Automation KG

36 ma_mu_sw-cv68-20428970_en

3 Port Expander Part No.
00F50C0-0080

4 Cable RS 485/DIN 66019II Part No.
00F50C0-0021

• Communication Port Expander to serial DIN 66019II (only Port 4). Type G6, F6, S6, H6
and P6.

• Communication Port Expander to HSP5 (Port 1-4) Type F5 and B6.

Part no. 00F50C0-4025 can also be plugged directly into the Sub-D9-pole HSP5 socket
of the F5 instead of the operator.
Further information can be found in the instruction manual. Please search for
"00F5025-0080“ or "Port Expander“ on the KEB homepage (► www.keb.de).
When searching for the devices, node addresses 0 to 4 must be set (Node 0 = Port Ex-
pander, Node 1-4 = HSP5-Ports X4A – X4D). For RS485 on Port 4, the node address
must be set to (node address of the device + 4).
The USB driver "FTDI_USB_Serial_Converter“ can be found in the COMBIVIS 6 Installa-
tion directory "C:\Programme\KEB\COMBIVIS_6\Drivers“ (please unpack first).

http://www.keb.de
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8 Device connection

8.1 Connection of COMBIVERT F5

1

Fig. 14: Connection of COMBIVERT F5 terminal X4A

1 HSP5 interface D-Sub 9-pole X4A:
USB serial converter Part No.
0058060-0040, Note 1)

1

2

Fig. 15: Connection_F5_2

1 HSP-5 diagnostic interface X6B at
fieldbus operators and interfaca op-
erator: KEB USB serial converter,
Part No. 0058060-0040, additionally
HSP-5 adapter D-Sub 9-pole / RJ45
Part No. 00F50C0-0020

2 By using an interface operator (Part
No. 00F5060-2000), connection at
D-Sub 9-pole, X6C: RS 232 cable
PC / operator Part No.
0058025-001D or KEB USB serial
converter, Part No. 0058060-0040.
Access also via IP operator, Part No.
00F5060-8000

Note 1:
After disconnecting the operator from the device, the baud rate of the device internal
HSP5 interface must be reset to 38400 baud by restarting the F5 (or set manually by
parameter Sy11 to 38.4 kBaud). The connection HSP5 operator works with 250kBaud,
which is too much for the PC.
Connection possible also by KEB Port Expander (≡► Port Expander 00F5025-0080
[} 33]).
On a free port of a PROFINET operator, COMBIVIS 6 can be operated in parallel to
PROFINET. Please see FAQ-documents for instructions.
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8.2 Connection COMBIVERT B6

1

Fig. 16: Connection_B6

1 HSP5 diagnostic interface X6B /
connection with USB serial converter
Part No. 0058060-0040 and HSP5
adapter D-Sub 9-pole / RJ45 Part
No. 00F50C0-0020 or port expander

Or (≡► Port Expander 00F5025-0080 [} 33])

8.3 Connection COMBIVERT G6

1

Fig. 17: Connection_G6

1 Instead of the operator: Interface
X4A Direct connection to serial
DSUB 9 pin protocol DIN 66019II :
KEB USB serial converter Part No.
0058060-0040 or RS-232 cable PC /
operator Part No. 0058025-001D

8.4 Connection COMBIVERT H6
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1

Fig. 18: Connection_H6

1 Connection of the drive units directly
to serial D-Sub 9-pole protocol DIN
66019II: KEB USB serial converter
Part No. 0058060-0040 or RS-232
cable-PC / operator Part No.
0058025-001D

Access to drive units also via control unit by IP UDP.

8.5 Connection COMBIVERT P6

1

Fig. 19: Connection_P6

1 Interface X6A, connection to serial
D-Sub 9-pole, protocol DIN 66019 II:
KEB USB serial converter, Part No.
0058060-0040 or RS-232 cable-PC /
operator Part No. 0058025-001D
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8.6 Connection COMBIVERT F6

8.6.1 Housing size D - W

1

Fig. 20: Connection F6 Housing D to W

1 Connection to serial D-Sub 9-pole,
protocol DIN 66019 II: KEB USB
serial converter Part No.
0058060-0040 or RS-232 cable-PC /
operator Part No. 0058025-001D
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8.6.2 Housing size 1 - 9

1

2

3

Fig. 21: Connection F6 Housing 1 to 9

1 F6 Pro: Multi Ethernet interface:
Ether-CAT or LAN switchable

2 Instead of the operator: interface
X4A Connection directly to serial D
Sub 9 pole protocol DIN 66019II :
KEB USB serial converter Part No.
0058060-0040 or RS-232 cable PC /
operator Part No. 0058025-001D

3 Via pluggable operator: LAN inter-
face: Part No. 00F6P00-2000 / USB-
B interface: Part No. 00F6P00-3000

At the COMBVIERT F6-Pro, the Ethernet bus interfaces (EtherCAT) can be switched to
Ethernet LAN.

8.6.2.1 Operator LAN (00F6P00-2000)

1

Fig. 22: Operator with LAN interface

1 LAN interface cable. The IP address
must be adjusted in parameter Fb01
by keyboard.

A good-shielded D-sub 9-pole extension cable can be used to connect the operator with
the diagnostic interface on the COMBIVERT S6/H6.
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8.6.2.2 Operator USB (00F6P00-3000)
Plug-in operator with USB interface Art. no. 00F6P00-3000.

1

Fig. 23: Operator with USB interface

1 USB A-B cable

A good-shielded D-sub 9-pole extension cable can be used to connect the operator with
the diagnostic interface on the COMBIVERT S6/H6.

8.6.2.3 Operator LAN/USB (00F6P00-4001)

➀ ➁
Fig. 24: Operator with USB and LAN interface

➀ USB A-B cable ➁ LAN interface cable. The IP address
must be adjusted in parameter Fb01
by keyboard.

A good-shielded D-sub 9-pole extension cable can be used to connect the operator with
the diagnostic interface on the COMBIVERT S6/H6.
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8.7 Connection COMBIVERT S6

1

2

Fig. 25: Connection_S6

1 Interface X4A: Connection directly to
serial D-Sub 9 pole protocol DIN
66019II: KEB-USB serial converter
Part No. 0058060-0040 or RS-232
cable PC / operator Part No.
0058025-001D

2 S6-Pro: Multi Ethernet interface:
EtherCAT or LAN switchable. The
COMBIVERT F6 operators (see sec-
tion 2.6.6) can also be used with
COMBIVERT S6 with a short D-SUB
9-pin extension cable (art. no.
0058025-004A).

The COMBIVERT F6 operators can be used at COMBIVERT S6 with short D-Sub 9-pole
extension cable.

8.8 Connection COMBIVERT T6

1

Fig. 26: Connection_T6

1 Connection via LAN interface by
standard LAN cable

8.9 Connection of C6 Stepper/BLDC
Connection via COMBICONTROL C6 with COMBIVIS studio 6
Sample project available. See document data bench: FAQ C6 RIO 0001 QuickstartStep-
perBLDC
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Fig. 27: Connection Stepper BLDC
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Fig. 28: Connection Stepper BLDC documents
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9 Installation
Since version 6.6.0 there is only one installation file. When installing, you can choose
whether the standard version COMBIVIS 6 or the extended COMBIVIS studio 6 version
shall be installed.
For new installations or when updating COMBIVIS 6, the selection is preset to COMBIVIS
6. When updating COMBIVIS studio 6, COMBIVIS studio 6 is also preset.

Fig. 29: Select components

Sand box installation / parallel installation
Since version 6.7.0 several COMBIVIS versions can be installed in parallel.
Applications:
• Allow parallel installation of the safety version and the non-safety version
• Retaining the old version
• Enable rapid pre-testing of beta versions, avoid impact on a productive environment

With parallel installation, some files are shared:
• Document Database
• Feature management
• KEB version manager

Some files are used individually:
COMBIVIS
• Parameter descriptions / Wizard descriptions
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• Database of the configurator
• Updates
COMBIVIS-Studio
• Complete development environment including compiler
• Libraries (optionally shared)
• Device descriptions (optionally shared)
Miscellaneous
• Visu-Profiles
• Options
• Packages, Plugins

When starting the installation, you can choose whether the previous version should be
deleted or retained.

Fig. 30: Installation Setup

• Uninstall: The older version is uninstalled and the new version is installed and replaces
the old version.



9 | Installation KEB Automation KG

48 ma_mu_sw-cv68-20428970_en

• Retain: The new version is installed and added.

Then there are 2 (or more) start icons on the Windows surface:

Fig. 31: Icons Desktop

Version Manager
On the start page you will find the Version Manager:

Fig. 32: Last_used_projects

Fig. 33: Installed versions

This allows the individual versions to be managed. The card "Installed" shows the in-
stalled versions:
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Fig. 34: Installation version manager

A specific version can be:
• started
• uninstalled
• excluded from the update
• directly updated

Versions provided by KEB but not installed are offered for installation on the card "Avail-
able" (Internet connection required):



9 | Installation KEB Automation KG

50 ma_mu_sw-cv68-20428970_en

Fig. 35: Version manager test version

9.1 Silent installation
The COMBIVIS 6 setup was created with the 'INNO Setup' installer. The setup file can
therefore also be executed in 'silent mode'. You can find further information on this at:
(► http://www.jrsoftware.org)

COMBIVIS (studio) 6.6.0 Setup can be configured in such a way that "Compact installa-
tion" is preset from the beginning:

For this purpose, parameter /TYPE="compact" must be added, e.g.:
"Setup_COMBIVIS_studio_6_V6.6.0_B227_R17.exe" /TYPE="compact"
Result:

http://www.jrsoftware.org/ishelp/index.php?topic=setupcmdline
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Fig. 36: Silent Installation Select Components

Prevent standard linking of CODESYS files (e.g.: file extension ".project") with CV:
"Setup_COMBIVIS_studio_6_V6.6.0_B227_R17.exe"/MERGETASKS="!associatePro-
jectFileExtension"

This can also be combined with the above command with the "Types" parameter.

9.2 Silent de-installation
Silent uninstallation is possible instead of standard uninstallation. To do this, open the
programme folder of the corresponding version.
The file "unins000.exe is then started with the corresponding parameters (see example).
Example:
unins000.exe /VERYSILENT /SUPPRESSMSGBOXES
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10 Registration and licence
Registration: valid for COMBIVIS 6, free of charge, enables access to the KEB docu-
ment database.
Licence: valid only for COMBVIS studio 6, chargeable, turns off the demo mode, in-
cludes registration.

10.1 Registration
The free registration of COMBIVIS 6 allows access to the document database. Configur-
ator, parameterisation, data backup and scope work without restriction in the demo ver-
sion.
Internet access must be available for registration. An account must also be created on
the KEB homepage. The registration key can be generated in the login area.
If you have a COMBIVIS studio 6 licence, this includes the registration.
An internet connection is required.
The registration link is on the home page:

Fig. 37: Carry out registration

You will be redirected to the KEB homepage:

Fig. 38: Registration KEB Homepage
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Login into your account.
If you don't have an account yet, you can create one under "Login/Logout":

Fig. 39: Registration Not registered, yet

Go to COMBIVIS Registration:

Fig. 40: COMBIVIS Registration

Create the registration key:
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Fig. 41: Registration Show registration key

Fig. 42: Registration key

The company name from the address range is the basis for the registration key.
The registration key is a 40-digit combination of letters and numbers.
Copy these two data into the registration window of COMBIVIS 6.

Fig. 43: Registration COMBIVIS 6
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After registration, a restart of COMBIVIS 6 is required.
The registration is not related to the computer and can also be used on several com-
puters.
The key is stored as the file "customer.nfo" on C:\ProgramData\KEB\COMBIVIS_6.

10.2 Licensing
The installed COMBIVIS studio 6 version is a demo version. It runs for a maximum of 1
hour and no boot projects can be created. After expiry, the demo version can always be
restarted again. To get the full range of functions, you need a licence. Please contact
your KEB sales organisation.
The licensing procedure for COMBIVIS studio 6 is described in the release notes: Menu
"Help“ → "Show release notes“.

Fig. 44: Registration Show release notes

The COMBIVIS studio 6 licence includes the registration.
(≡► Registration [} 52])
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11 Programme description
The following section describes the individual elements of the programme interface.

➊
➋

➌ ➍

➎

Fig. 45: Start screen

➊ Menu bar ➋ Toolbar
➌ Navigator ➍ Start page
➎ Messages

11.1 Menu bar
The following image shows the menu bar with factory settings. Depending on the project,
further menu items can be displayed.

Fig. 46: Menu bar

Only menu items that can be executed for the corresponding program functions are dis-
played in the submenus. All others are greyed out.
The menu bar and submenus can be customised using the Tools => Customize... Menu.
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11.1.1 Menu - File

Fig. 47: Menu bar - File

New Project...
Opens a window for creating a new project.
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Fig. 48: File - New project

• Name
Enter a project name.

• Location
Select the storage location for the project.

• KEB device scan
Select "KEB device scan" and OK or double-click on "KEB device scan" to start the wiz-
ard and list all devices found. The selected devices are transferred to the project by
clicking on the "Add selected devices" button.

• Empty project
Select "Empty project" and OK or double-click on "Empty project" to create an empty
project tree.

Open Project...
Open the window for selecting and opening files. All files supported by COMBIVIS are
available for selection. With the combination button, you can choose between Open and
Open read-only.
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Close Project
Closes the current project.

Save Project
Saves the current project without closing it.

Save Project as...
Opens the window for selecting the storage location, file name and file type. The com-
mand button Save saves the project with the selected settings.

Print
Opens a window with the possible print settings.

Page settings
Opens a window for defining individual page settings.
The following tabs are available for customisation:
• Paper
• Margins
• Header and Footer
• Document
• Title Page

Last used projects
Displays a list of recent projects. Click to open a project.

Restart
Closes the current project and restarts the programme. Changes can be saved before
closing.

Exit
Closes the current project and exits the programme. Changes can be saved before clos-
ing.
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11.1.2 Menu - Edit

Fig. 49: Menu - Edit

Undo
Undoes the last programme input step by step. Does not apply to values that are trans-
mitted to connected devices.

Redo
Restores an undone entry.

Cut
Cuts project parts (e.g. parameter lists) from the current project and copies them to the
clipboard for further processing.

Copy
Copies project parts (e.g. parameter lists) from the current project to the clipboard for fur-
ther processing. Device parameters are copied to the clipboard with the parameter name
and value for further use.

Insert
Inserts project parts (e.g. parameter lists) from the clipboard into the current project.

Delete
Deletes project parts (e.g. parameter lists) from the current project.

Select all
Selects all lines, e.g. from a parameter list.
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Find Replace
Opens a dialogue box with various search functions.

Next message
Used to navigate forwards in the message window.

Previous message
Used to navigate backwards in the message window.

11.1.3 Menu - View
The current screen view is defined in the view menu. The listed elements can be dis-
played.

Fig. 50: Menu - View

Navigator
Used to show the navigator. The navigator is displayed as a window or tab.

Property Editor
Used to show the Property Editor. The property editor shows all properties for the selec-
ted parameter on the "Device parameters" tab.

POUs
Display of programme organisational units (e.g. the project settings). The POUs are dis-
played as a window or tab.

Messages
Window in which errors, warnings and messages are displayed.

Start page
Displays the start page in the main window.
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Full screen
Switches COMBIVIS to full screen display or back to window mode. Alternatively, you can
also use CTRL + Shift + F12 to switch.

Properties
Shows the properties for the currently selected object in the main window.

11.1.4 Menu - Project

Fig. 51: Menu bar - Project

(≡► List KEB devices [} 105])

(≡► KEB device scan [} 93])

(≡► Add KEB device [} 94])

Comparing parameter lists
(≡► Online comparison [} 228])
(≡► Offline comparison [} 229])
(≡► Comparison method [} 229])

(≡► Add parameter list [} 207])

(≡► Add object [} 67])

Add folder
Opens a window for entering a folder name. Click OK to save the folder to the active ob-
ject.
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Edit Object
This entry opens the currently selected object for editing.

Edit Object With
If several editing options are available for an object, a selection is opened. Otherwise the
same function as "Edit object".

Project Information
File
Shows basic information such as name, storage location, attributes and more.

Summary
Allows you to enter additional information about the project such as company, author ...

Properties

Statistics
Shows an overview of the objects and their number in the project.

Licensing
Enables the library to be licenced with a dongle.

11.1.5 Menu - Tools
Package Manager
A list of already installed packages is displayed here. These can be uninstalled or others
can be installed.
The "Details" button provides further information on the selected package, as well as in-
formation on licences.

Licence repository
Display of all installed licences. Import option for tickets.

Licence manager
Used to install purchased licences.

Customise
The menu, toolbars, keyboard shortcuts and command icons can be customised/as-
signed here.

Options
Here you can made (≡► General settings [} 135]).

Import and Export Options
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(See general settings)

Import KEB parameter description file
Manual updating of the (≡► parameter description file [} 311]).

Reload parameter descriptions
After the import, the file must be reloaded or COMBIVIS must be restarted.

KEB FTP
Exchange of data via (≡► FTP connection [} 321]).

IPScan
The (≡► IP scan [} 333]) Tool is used to easily locate accessible devices in your own
subnetwork.

KEB Documents
The COMBIVIS internal document database can be used to view all (≡► KEB Docu-
ments [} 287]). The programming manuals of COMBIVERT F5, G6 and F6/S6/H6 are in-
tegrated in the basic configuration.

Manage KEB Documents
Here you can find more (≡► Documents [} 284])such as instructions, catalogues and E-
plan data can be downloaded as data packages via the Internet.

Parameter backup
The (≡► Parameter backup [} 232]) allows you to save one or more parameter lists.

11.1.6 Menu - Window
The standard Windows functions are available here.
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11.1.7 Menu - Help

Fig. 52: Menu - Help

Content
Start the integrated COMBIVIS manual.

Index
Start the integrated index search.

Search
Start the integrated search.

Services and support
Click to open the KEB website "Services and Support". Here you will find addresses, tele-
phone numbers and e-mail addresses for the various product groups. The "TeamViewer
Quicksupport" software is also available for download.

COMBIVIS 6 Show operating instructions
Opens the COMBIVIS6 operating instructions with the integrated PDF viewer.

"FAQ" - Show documents
Opens the document database and filters it for FAQ documents.

Show release notes
Opens the pdf document with the release information for COMBIVIS 6 and COMBIVIS
studio 6.

Visit KEB website
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Opens the KEB homepage.

Check for updates
Manual search for updates to programs, drivers, parameter descriptions and documents.
If the "Show only recommended updates" checkbox is unchecked, all available down-
loads are displayed.

Informations
Shows current information of the program version and registration.

11.2 Toolbar
The toolbar changes the available icons depending on the selected object.

Fig. 53: Toolbar

If you leave the mouse pointer over an icon, a tool text about the function is displayed.

Fig. 54: Toolbar - Tool text icon

11.3 Navigator
The navigator shows all devices, lists, offline wizards and other objects contained in the
project.
The navigator normally appears on the left side of the window. If it is not visible there, it
can be displayed with the menu bar "View" → "Navigator.

Fig. 55: Navigator
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➀
➁

➁

Fig. 56: Navigator - Predefined Folders

➀ Project name ➁ Device in the project

Predefined folders are attached to the project and to the device (parameter cockpits (≡►
Parameter cockpit [} 344]), Parameter lists (≡► Parameter lists [} 207]), Scopes (≡►
Scope [} 239]), Wizards (≡► Start-up Assistant (Wizards) [} 150]). If these are not re-
quired, they can be deleted.
Click on project name or device name → right mouse button → "Add object" to add
folders, parameter lists, scopes, etc.
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Fig. 57: Add_object

Objects attached to the project are valid for several devices, objects attached to the
device are only valid for this device.

see also
2 Parameter cockpit [} 344]
2 Parameter lists [} 207]
2 Scope [} 239]
2 Start-up Assistant (Wizards) [} 150]

11.3.1 Display of the communication status:
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Fig. 58: Device_active_inactive
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Fig. 59: Device_active_no_connection

Alternatively, the communication status can also be changed via the context menu: right
mouse button → "Online" / "Offline

Fig. 60: Navigator_communication_status_online_offline

11.3.2 Rename elements
The names of the elements in the Navigator can be changed in two ways.
Please note! Device designations must not begin with a number.

Click twice slowly on a single element with the left mouse button. Then the new name can
be entered.
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Fig. 61: Change element name

Right-click on an element to access the function via the menu item Properties:

Fig. 62: Properties menu item

A dialogue window then opens. The default designation can be overwritten here.
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Fig. 63: Rename elements

11.3.3 Add configuration
The KEB Configurator is a tool for easy modelling of a KEB drive system. While assem-
bling these models you are supported by an intuitive Graphical User Interface (GUI) and
different component selection wizards.
The systems assembled with the configurator can be used for various purposes. On the
one hand, a configuration is used to document a planned or created drive system from
KEB components. Furthermore, the information from the configuration can be used to
generate COMBIVIS (or COMBIVIS studio) projects and part lists, e.g., for requesting a
quotation.
The configurator also provides easy access to the technical data of KEB devices and
their documentation.
Note:
In the configurator, the standard portfolio of KEB is included. For special options, please
contact directly to the KEB sales.

Right-click on the project name, then left-click on "Add object" > "Configuration" to start a
new configuration.
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Fig. 64: Add configuration

11.3.3.1 Work with Configurator
The Configurator consists of 3 main parts:

Fig. 65: Work with Configurator



11 | Programme description KEB Automation KG

74 ma_mu_sw-cv68-20428970_en

1. Workspace
Here all selected devices are shown, placed, and connected.
2. Product selection window
The elements are shown that can be used in the Configurator.
3. Properties window
The properties of the elements selected in the workspace are shown.

11.3.3.1.1 Workspace

1

2

Fig. 66: Work with Configurator

1 Placed and connected elements /
system components

2 Miniature view with zooming option

11.3.3.1.2 Connections
Connections / cables can be inserted from the product selection or by drawing a new con-
nection from an interface with the mouse:
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1

Fig. 67: Configurator connections

1 Possible interfaces for a connection
are highlighted.

A fitting connection is automatically inserted. If multiple connections are possible, one
must be selected from the dialog that will appear automatically in this case.

11.3.3.1.3 Document access
Using the context menu "Show Documents", it is possible to access all documents asso-
ciated with that element:
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Fig. 68: Configurator Document access
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11.3.3.1.4 Product selection window

1

2

3

Fig. 69: Configurator product selection window

1 Part number filter 2 Start selection wizard
3 Select elements via double click or

drag & drop

Example of a product selection wizard:
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Fig. 70: Configurator product selection

If no wizard is available, the elements will be shown in a table. This view is also available
from a wizard using the “Expert view” tab.

11.3.3.1.5 Properties window

1
2

Fig. 71: Configurator properties window

1 Expert view 2 For each column, a filter can be set.
Green = Filter active
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1

2

Fig. 72: Configurator properties window input

1 Name of the selected device: Device
name / position of the name field

2 Technical data of the selected
device

11.3.3.2 Generate COMBIVIS project
From a configuration the contents of a COMBIVIS project can be generated. This is done
via the menu:

Fig. 73: Configurator Create COMBIVIS project

Or via tool bar:

Fig. 74: Configuration Icon export configuration

This menu command opens a preview dialog where additional adjustments can be made:
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Fig. 75: Configurator generate project

In COMBIVIS studio 6 in addition to the parameter based devices also PLC devices with
complete EtherCAT or CAN-Bus topologies can be generated:

Fig. 76: Configurator Generate Project Preview

Depending on the size of the project to generate this might take a moment.

After the generation, the relation between the elements in the configuration and the cre-
ated objects persists, which enables additional functionalities:

Open created objects:
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Fig. 77: Configuration open created objects in COMBIVIS

Using the context menu all generated objects can be opened. Open in Configuration:
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Fig. 78: Configurator Show items in configuration

From the navigator the corresponding elements can be highlighted in the Configurator.
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1

Fig. 79: Configurator Highlighted elements

1 Highlighted elements blink for some
seconds.

11.3.3.3 Part list
The part list is available using the menu:

Fig. 80: Export configuration

Or via tool bar:

Fig. 81: Configurator Export Icon configuration

The part list contains all elements from the configuration. There are options to customize
the view. Different export formats are available as well as a print option.
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Fig. 82: Configuration Export

11.3.3.4 Assign documents
In the “Documents” tab of the editor for KEB devices all relevant documents for that
device can be listed and viewed with one click. This list contains for instance all docu-
ments for the device and the connected motor.
(≡► Use document database [} 287])
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11.4 Start page

➊ ➋

➌

➍

Fig. 83: Start page

➊ Last used projects ➋ Quick start menu
➌ Online ➍ Options
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12 Startup
Working with a device in COMBIVIS 6 always requires the creation of a new project or the
opening of an existing project.

Communication with the device can be established via:
• Creating a new project and project wizard (≡► Start with the project assistant [} 87])
• (≡► Direct device search [} 93])
• Manual setting of communication values with known hardware (≡► Direct connection

to the device (add device) [} 94])

For the last two points, a temporary project is always created in the background first. This
can then be saved via "File" →"Save project as...".

If only an existing parameter list is to be loaded into a KEB COMBIVERT, the function
"(≡► Download of a parameter list [} 98])" can be used on the start page.
COMBIVIS 6 always starts with the home page in the default setting.

Fig. 84: Show start page

The home page can be reactivated at any time with this icon

When the mouse pointer is positioned on a button, a description of the function is dis-
played.
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Fig. 85: Start page Mouse pointer

➊

➋

Fig. 86: Used projects list

➊ The vertical pin permanently at-
taches project names to the list.

➋ The "cross" deletes the selected pro-
ject name from the list.

see also
2 Startup [} 86]

12.1 Start with project assistant

12.1.1 Start with the project assistant
The automated "Project Wizard" opens a new project, performs a predefined search for
connected devices and integrates the found devices into the project.
After clicking on "New project", the "Project wizard" window is opened. Alternatively, one
of the last projects can also be opened.



12 | Startup KEB Automation KG

88 ma_mu_sw-cv68-20428970_en

1

2

Fig. 87: New_Project

1 Open any project 2 Open one of the last saved projects

• "Empty project" opens an empty project. The device search / integration must then be
startet manually.

• "KEB Device Search" opens the device search window

1

Fig. 88: Project name

1 Enter project name and location

The device search depends on the pre-configuration and runs automatically. Device
search window:
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1

Fig. 89: Device search

1 The search can be started, stopped,
the settings can be changed and re-
started.

The explanation of the window function can be found at (≡► Manual device search
[} 90]).
If devices were found, continue with (≡► Device editor [} 104]).
If one or more device(s) were not found, adjust the search settings, continue with (≡►
Manual device search [} 90]).
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12.1.2 Start with an empty project

Fig. 90: Working with an empty project

With an empty project, a specific device search can be carried out with connected
devices, and a manual device integration can be carried out without connected devices.

12.1.3 Manual device search
Open an empty project and (or from an existing project:) execute menu bar "Project" →
"KEB device search".

Fig. 91: Manual device search

or click on the icon for "manual device search":
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Fig. 92: Icon manual device search

The search process can be influenced in the device search window.
In deviation from the initial setting, other COM interfaces, addresses, baud rates or IP ad-
dresses can be temporarily searched.

1

2

3

4

5

6

7

Fig. 93: Device_search_UDP_IP

1 Search area UDP/IP 2 Search area COM interfaces
3 Stop search 4 Start search
5 Adopt selected setting for future

searches
6 Select devices to be added

7 Add found devices to the current
project

By searching via USB serial converter on COMBIVERT F5/B6 (HSP5 protocol), please
note the information (≡► under KEB USB serial converter. [} 29])
If the communication data is known, a device can also be set directly without search (≡►
Direct device search [} 93]).

12.1.4 Start offline (without connected device)
A fictitious device can be added manually in the project. This can then be used, for ex-
ample, to create a parameter list offline.
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→ Open empty project → Click with left mouse button on toolbar: "Add parameterisable
KEB device“

Fig. 94: Add Icon parameterisable KEB device

1

2

3

Fig. 95: Add_device

1 Select device group / type or config-
uration number

2 If necessary, select operator or con-
trol type (G6)

3 Enter: "Add device"

For help in selecting the correct device group for F5 and G6, there is an overview avail-
able in the FAQ documents: Menu "Help" → "Display FAQ documents" → "COMBIVIS 6"
→ "CV6 FAQ0005 F5 G6 Short names operating modes".

Enter or accept the name of the device to be inserted.



Startup | 12

ma_mu_sw-cv68-20428970_en 93

Fig. 96: New parameterisable device

The device name must not begin with a digit, COMBIVIS then places an underscore at
the beginning of the word.
Offline device is added and the device editor window opens. (≡► Direct device search
[} 93]).

12.2 Direct device search
With the selection field "Search for devices" on the home page, a temporary project is
created and the device search window is opened. The search must be started manually
after setting the hardware configuration.

Fig. 97: Icon direct device search
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1

2

3

4

5

6

Fig. 98: Device search_Ethernet

1 Search area Ethernet 2 Search area serial interfaces
3 Stop search 4 Start search
5 Select devices to be added 6 Add found devices to the current

project

The activated devices are displayed in the navigator window.

12.3 Direct connection to the device (add device)
With the selection field "Connect to device" a temporary project is created and the win-
dow with the interface properties is shown.
With an online connection, after setting the connection data, a scan is carried out and
found KEB devices are displayed immediately.
Because COMBIVIS knows all parameters of all KEB devices (from type F5), a device
can also be created "virtually".
When connected via UD/IP (Ethernet):
The window shows an input field for the IP address. At the same time, a network scan is
carried out and the found devices are listed. Standard port and node address are auto-
matically detected.
The devices found via the IP address are listed below and can be transferred to the pro-
ject.
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Fig. 99: Icon direct connection to the device

1

2

3

4

Fig. 100: Add_all_devices

1 Set IP address 2 Devices found in the network
3 Devices found under the IP address 4 Enter: Single "Add device" - window

remains open "Add and close all
devices" - window closes



12 | Startup KEB Automation KG

96 ma_mu_sw-cv68-20428970_en

With the KEB port expander item no. 00F5025-0080, the devices are found
on each searched port (8000 and 8001) and listed twice during the auto-
matic search. Please set a fixed port here.

For serial or USB connection:

1

2

3

4

Fig. 101: USB_connections

1 Set communication data. Detected
USB connections are suggested. Set
baud rate manually. Typically 38400
baud for x6 devices.

2 "Communication Test" runs once for
each setting change. Found devices
are listed immediately.

3 Enter: "Add device" - Add this device
to the project and window remains
open.

4 "Add all devices and close" - window
closes.

12.3.1 Offline (virtual device):
When "Offline", the device can be selected manually on the basis of the type/firmware
version or if the configuration identifier is known.
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1

2

3

4

Fig. 102: Add_device_1

1 Set type 2 Enter the configuration identifier
manually

3 Set available operator (or the control
version for G6)

4 Add device

The device(s) are displayed in the navigator window.

12.4 Open an existing project

1

2

Fig. 103: New_Project

1 Open any project 2 Open one of the last saved projects

or:
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1

2

Fig. 104: Start Up last used projects

1 Open any project 2 Open one of the last saved projects

If a project is opened without connected devices, the last connection status is retained
when saving again.

12.5 Download of a parameter list
The function specifies a path with which a parameter list saved somewhere can be down-
loaded into a KEB device.
A temporary project is created with the selection field "Download of a parameter list", the
parameter list is opened, the window for connecting the device is displayed and after the
connection the parameter list is loaded into the device.
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Fig. 105: Download_Parameter list

Mark and "open" the parameter list:

Fig. 106: select the file download of a parameter list

12.5.1 When connected via UD/IP (Ethernet):
The window shows an input field for the IP address. At the same time, a network scan is
carried out and the found devices are listed. Standard port and node address are auto-
matically detected.
The devices found via the IP address are listed below and can be transferred to the pro-
ject.
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1

2

3

4

Fig. 107: Add_all_devices

1 Set IP address 2 Devices found in the network
3 Devices found under the IP address 4 Enter: "Add device" - window re-

mains open. "Add all devices and
close" - window closes.

With the KEB Port Expander, item no. 00F5025-0080, the devices on each
searched port (8000 and 8001) are found and listed twice during the auto-
matic search. Please set a fixed port here.
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12.5.2 For serial or USB connection:

1

2

3

4

Fig. 108: USB_connections

1 Set communication data. Detected
USB connections are suggested. Set
baud rate manually.

2 "Communication Test" runs once for
each setting change. Found devices
are listed immediately.

3 Enter: "Add device" - Add this device
to the project and window remains
open.

4 "Add and close all devices" - window
closes.

Confirm download with "Yes".

Fig. 109: Confirm_parameter_list_download
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After the download is complete, the success is displayed in the message window in the
lower window area:

Fig. 110: Download_completed

The download has been completed and COMBIVIS can be closed.

12.6 Saving a project
The project can be saved under "File" → "Save project" with the same name or "Save
project as..." with a new name.

Fig. 111: Save_project

Save compatible to older version:
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If the project shall be opened on another PC with an older version of COMBIVIS, it is re-
commended to save the project compatible to this version. Otherwise you get an error
message when you open it and you have to adapt the project:
"File" → "Save project as..." → File type

Fig. 112: Compatible_older_version

The file types (*.library) are generated by CODESYS and can be ignored here. If a profile
of an older version is required, please contact KEB.
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13 Device editor
Data communication is online, all parameter values are changed directly in the device.
A parameter backup of the device must be made via its own parameter list (≡► Para-
meter backup [} 232]).
Each device has its own device editor.

13.1 Opening the device editor
There are two ways to open the device editor:

1

2

3

Fig. 113: Open_Device_Editor

1 Double-click on the device name
with navigator or:

2 mark the device (or devices) to be
edited (1.) - Click arrow down.

3 "Open in Editor"
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Fig. 114: Opening_the_device

13.2 Device reference
The device reference is the instrument to clearly distinguish the individual devices in the
project. This is assigned in the order in which it is found during the device search and de-
scribes the position of the device in the data bus. It is independent of the (device) node
address.
I.e. if the wiring is changed and a new search is made, the device reference may be
changed!
The device reference is only assigned once and cannot be changed manually!
An overview list with all devices can be displayed:
Context menu "right mouse button" in the Navigator window → "List KEB devices“
In the menu bar: "Project" → "List KEB devices“
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Fig. 115: List device reference KEB devices

Fig. 116: Device reference configurable KEB devices

13.3 Switch active device offline
To protect an active device against accidental operation or if the communication data is to
be changed, individual devices can be excluded from communication:
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1

Fig. 117: Switch_devices_online_offline

1 Right-click on the device. Click on
"Online" and remove or set check
mark.

Alternative:
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1

2

Fig. 118: Devices_online_offline_alternative

1 Select device 2 Connect or disconnect the device

13.4 Screen layout

1

2

3

Fig. 119: Screen layout

1 Navigator: Representation and activ-
ation of the individual devices and
objects in the project

2 Editor: Editing of devices and ob-
jects, division into tabs according to
a) devices and b) editors for each
device

3 Program messages: Status, warning
and error messages are displayed
and logged
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13.5 Communication settings

➊

➋

➌
➍ ➎ ➏ ➐

➑

❾
❿

Fig. 120: Communication settings

➊ Selection of the function tables of a
device or object.

➋ Device name

➌ Communication data node/device
address status of the device, online /
offline

➍ Switches the current device offline/
online.

➎ Changing the communication set-
tings (offline only).

➏ Resets the baud rate to the factory
setting.

➐ Searches for the maximum possible
baud rate for serial communication
and sets the value. The device must
be online for this.

➑ Current firmware (configuration) ID
of the device stored in the project.

❾ Current firmware (configuration) ID
of the operator stored in the project.

❿ Expert settings: Addressing type for
this device deviating from the global
project setting.
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❶

❷

Fig. 121: Expert settings

❶ Addressing type for this device devi-
ating from the global project setting.
[} 113]

❷ Device reference number in the pro-
ject (not the device address!) [} 105]

Further information:
Description of the addressing types (≡► Set addressing [} 113]).
What means the (≡► Device reference [} 105])?

13.6 Online wizard / commissioning assistant
Depending on the device type, commissioning wizards are offered (≡► Start-up Assistant
(Wizards) [} 150]).

Fig. 122: Online_wizard



Device editor | 13

ma_mu_sw-cv68-20428970_en 111

13.7 Device parameter
In the device parameter tab, the function parameters of the device (drive controller) are
displayed in the current state. Changeable parameters can be changed here directly in
the device. Parameters of the pluggable operators at COMBIVERT F5 or the control
cards of COMBIVERT B6 and G6 are displayed in the tab operator parameter.

①
②

③

Fig. 123: Devices_Parameter_1

① Parameter groups: Open by clicking
on "+" or "Enter" / "Space"

② Open set-parameterisable paramet-
ers or ARRAYs

③ Change values of parameters: Mark
parameter and "Enter" or "Double-
click" with left mouse button, change
value in property editor.

(≡► Help for parameter functions [} 352])
A distinction is made between parameter groups:

Fig. 124: Devices_Parameter_2

Set-parameterisable parameters or ARRAY and STRUCT. By opening with "+", you can
access the individual parameters in the sets or the subindices:
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Fig. 125: Devices_Parameter_3

and variables: The variables are global and have the same value for type F5/ G6/ B6 in
all parameter sets. (Blue cube: writeable and readable, grey cube: read only)

Fig. 126: Devices_Parameter_4

Further properties in the context menu:
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1

2

3
4
5

Fig. 127: Devices_Parameter_5

1 All parameters displayed on the screen are up-
dated.

2 Only the selected parameters are displayed and
updated.

3 Opening the parameter groups with keys r, o, p,
c... possible (F8), closing with "Space"

4 Creates new parameter list with marked para-
meters.

5 Displays an explanation of the parameter in
KEB documents.

13.7.1 Set addressing
Set addressing is used for COMBIVERT F5/G6/B6.
The parameter sets are selected in the basic setting of COMBIVIS 6:
• for devices with KEB set addressing (COMBIVERT F5, B6 and G6 (V1) in a direct way

(switchable to "active set" or indirect).
• for devices with CANopen addressing (COMBIVERT G6 (V2),) according to CiA 301

(cannot be switched).
Setting in toolbar - "Tools" → "Options" → "KEB Parameterisation" → Tab: "Parameter“
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Fig. 128: Set-addressing_1

Fig. 129: Set-addressing_2

Or only for the current device in the "Device Editor" → "Communication Settings" → "Ex-
pert Settings" → "Explicit":
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❶

❷

Fig. 130: Device_2

❶ Addressing type for this device devi-
ating from the global project setting.
[} 113]

❷ Device reference number in the pro-
ject (not the device address!) [} 105]

Which addressing is currently being used is permanently displayed in the editor at the
bottom edge.

Fig. 131: Set-addressing_3

13.7.2 Direct addressing
For each parameter, it is shown to which set it belongs.
The first sub-view shows the parameter which is addressed directly (here: set 0 and 2).
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Fig. 132: Direct_addressing_1

In the second sub-view (second "+"), all 8 parameters are always displayed with direct
addressing.

Fig. 133: Direct_addressing_2

With direct addressing, you can also access parameters of several sets at the same time:
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Fig. 134: Direct_addressing_3

Fig. 135: Direct_addressing_4

13.7.3 Indirect addressing
Occurs indirectly via parameter pointer Fr09. The values displayed in the first sub-view
belong to the adjusted set in Fr09 (parameters that cannot be set are always the same in
all sets).
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Fig. 136: Indirect_addressing_1

Fig. 137: Indirect addressing parameter set pointer

Only the parameter set pointer Fr09 shows to which set the currently displayed parameter
values belong! The pointer is therefore permanently shown in the editor at the bottom.
The setting of the set pointer Fr09 occurs in the editor at parameter Fr09 or directly with

the icon: 
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Fig. 138: Indirect addressing Fr09

In the second sub-view (second "+"), all 8 parameters are always displayed with direct
addressing.

13.7.4 Active set
In the first sub-view the parameters of the set are shown and parameterised with which
the drive controller is currently running. Display in parameter ru26, active set at the bot-
tom of the editor or in the editor
In the second sub-view (second "+"), all 8 parameters are always displayed with direct
addressing.
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Fig. 139: Active set parameters

Fig. 140: Active set setpoint source

13.7.5 Addressing according to CiA 301.

Addressing of the COMBIVERT F6, H6, P6, S6, T6. The addressing occurs according to
CiA 301.
VARiables are marked with blue or grey cube. (blue: readable and writable / grey: read
only). The parameter value is in the line.
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Fig. 141: Addressing according to CiA 301 variables

STRUCTure parameters are marked with a "tree symbol" . The associated sub-in-
dices are again marked with blue/grey cubes (blue: readable and writable / grey: read
only).

Fig. 142: Addressing according to CiA 301 ru82

ARRAY parameters are marked with a "tree symbol“ . The associated sub-indices
are again marked with blue/grey cubes. (blue: readable and writable / grey: read only)
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Fig. 143: Addressing according to CiA 301 ru83

STRING parameters contain text. Available only in COMBIVERT F6-Pro and S6-Pro (e.g.
fb110)

Fig. 144: Addressing according to CiA 301 fb110

Addressing of the COMBIVERT G6
Addressing according to CiA 301 is similar to direct set addressing with COMBIVERT F5.
There are ARRAYs and VARiables. The ARRAYs have x subindices. The subindices are
numbered from 1 to x. Set 0 corresponds here to subindex 1.Set 1 to subindex 2, etc.
In the first sub-view (parameter sets closed), the number of available subindices is dis-
played for set-parameterisable parameters and the parameter value is displayed for non-
set-parameterisable parameters.
Indirect addressing, "active set" and addressing of several parameters simultaneously are
not supported!
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Fig. 145: Addressing COMBIVERT G6 according to CiA 301 CANopen

The display of the closed ARRAYs or parameters in the group view can be changed.

Under "Tools" → "Options" → "KEB Parameterisation" → Tab: "Parameters“ → "AR-
RAYs“ you can set whether the value of the first subindex should be displayed.
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Fig. 146: Addressing according to CiA 301 parameters

Or in the context menu: Right mouse button → "Display subindex [1] for ARRAYs".

Fig. 147: Addressing according to CiA 301 subindex

13.8 Operator parameters
The tab only appears when an operator is detected. For COMBIVERT B6 and G6, the in-
ternal communication control card is designated as "operator".



Device editor | 13

ma_mu_sw-cv68-20428970_en 125

Same mode of operation as for the "Device parameters" tab

Fig. 148: Operator parameters tab

13.9 Documents
All available manuals are displayed in the documents tab. By entering the device part
number, only the associated documents are displayed. Part numbers entered here are
permanently assigned to the device, but can be changed by overwriting them.

Fig. 149: Documents tab

(≡► Document database [} 284])

13.10 Switching between editors
Switching between the editors can be done by:
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• Clicking on the editor tab
• Double-click on the object in the navigator

Fig. 150: Change_between_editors_1

Key combination "CTRL+TAB"
With the "CTRL" key held down, the "←", "↑", "→", "↓" keys can be used to select the ed-
itor or view to be opened. Only active editors are displayed.

Fig. 151: Change_between_editors_2
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13.11 Device memory (recipe management)
The KEB COMBIVERT F6/ S6 have the function Recipe management. Certain parameter
lists are stored in the device memory and can later be loaded into the runtime environ-
ment in various ways.
To save the files, the device memory wizard ((≡► Device storage wizard [} 312])) or the
KEB (≡► FTP [} 321]) can be used.

Fig. 152: Device memory (recipe management)
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14 Property editor (input window)
To change the parameter value, the input window can be opened by double-clicking on
the current parameter value or by marking it and pressing the "Enter" key.

Fig. 153: Property editor (input window)

14.1 Initial setting
Under: "Tools" → "Options" → "KEB Parameterisation" → "Behaviour" you can define in
the "Property Editor" field whether the input window is only sequentially or always visible.

Fig. 154: Basic setting Tools options
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Fig. 155: Basic setting Behaviour

14.2 Function selection
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1

2

3

4

5

Fig. 156: Function selection

1 The value is accepted with "OK" or
the "Enter" key.

2 Scroll bar

3 The input value is accepted with
"OK". It can also be typed directly as
a digit.

4 Open selection table

5 Scroll bar

14.3 Numerical value input
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1
2

3

Fig. 157: Numerical value input

1 The value is accepted with "OK" or
the "Enter" key.

2 Scroll bar can be moved with the
mouse.

3 Direct input of the numerical value.
The value is accepted with "OK".
The unit is automatically inserted.

Depending on the international setting of the MS-Windows, "comma" (Ger-
man) or "dot" is used as a separator for fractional numbers. In German, the
dot is interpreted as a 1000 separation.

14.4 Parameter properties / background information
The stored device description file contains a lot of information about the device paramet-
ers. These are shown when you click on the small triangle at the bottom of the input win-
dow.
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Fig. 158: Parameter properties_1
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1

Fig. 159: Parameter properties_2

1 A mouse click on the triangle opens
a window that shows basic data of
the parameter: Hexadecimal ad-
dress, limits, default value, resolu-
tion, data length, etc.
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14.4.1 Plain text export according to IEC 61131-3
With the version COMBIVIS studio 6 you can export the display texts in IEC 61131
format. At parameter: Context menu→ "Generate IEC 61131-3 code" → "Generate plain
text function".

Fig. 160: Generate plain text export according to IEC 61131-3 code

Fig. 161: Plain text export according to IEC 61131-3 code text
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15 General settings
General and special options can be indicated and adjusted in “Tools” → “Options…”.

Fig. 162: Tools options

These settings will be saved automatically non-volatile when COMBIVIS 6 is closed. In
the event of a version update, the option settings are retained.
The settings can be exported and imported on another computer: Menu bar "Tools" →
"Import and Export Options..."

Fig. 163: Tools Import and Export Options
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Fig. 164: Import and Export Options

15.1 Options - Language Settings
There are 3 language areas:
• Program language
• Parameter language
• Help
These can be handled independent. If a language is not available English is shown.
Setting the program language and help under: Toolbar –"Tools“ → "Options“ → "Interna-
tional Settings“.
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Fig. 165: International Settings

The parameter language can be adjusted by: "Options“ → "KEB Parameterization“ →
"Parameters“.
(≡► KEB Parameterization - Parameter view [} 139])

15.2 Configurator
KEB Configurator initial settings can be set here. They apply to each new start of the con-
figurator KEB Configurator.

Fig. 166: Configurator_1
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Fig. 167: Configurator_2

15.3 Options - KEB documents

Fig. 168: KEB dokuments

(≡► Document database [} 284])

15.4 Options - Online update
KEB COMBIVIS 6 can search for available updates and install if an internet connection is
available. Not only program updates are searched for, but also updates for manuals,
parameter description files (required at firmware update in KEB devices) and libraries.
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1

2

Fig. 169: Options_Online_Update_1

1 Activates the automatic online up-
date.

2 Selection: When to check for up-
dates.

Automatically check for updates weekly/monthly means: next test 7/30 days after the last
test if an Internet connection exists or at the next connecting after this date.
If the Internet connection cannot be established via the standard proxy settings, the set-
ting for COMBIVIS 6 can be made separately.

Fig. 170: Options_Online_Update_2

15.5 KEB Parameterization - Parameter view
Setting for the display of the device parameters in the device editor.
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Fig. 171: Parameter view

1 Parameter language: If language file
is not available, English will be used.

2 Set-addressing of parameters when
creating a parameter list.

3 Display of normally invisible service
parameters.

4 Display of service parameters with
special password protection.

5 Settings for drive profiles according
to CiA 301. Instead of number of su-
bindices the value of subindex 1 is
shown (Only useful with
COMBIVERT G6).

A change of the parameter language is implemented immediately. No program restart is
required.
(≡► Set addressing [} 113])

15.6 KEB Parameterization - Communication
Settings for the communication with the devices.
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➊
➋

➌

➍

Fig. 172: Options - KEB Parameterisation - Communication

➊ Timeout ➋ Connection test each x seconds
➌ Close communication channels

when application is minimised
➍ Assignment of interface / transmis-

sion rate. The number of COM inter-
faces depends on the PC hardware.

15.7 KEB Parameterization - Parameter lists
Default settings of new opened parameter lists.

Fig. 173: KEB Parameterization - Parameter lists
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15.8 KEB Parameterization - Behaviour
Settings for the behaviour of COMBIVIS 6.

1

2

3

Fig. 174: Behaviour

1 Behaviour at error messages 2 Behaviour of the property editor (in-
put window)

3 Available assistants will be directly
opened in the project.

(≡► Property editor (input window) [} 128])

15.9 Parameterization - Data paths
Data path for the parameter description file (XML-file). Depending on operating mode and
firmware for each KEB device one or more parameter description files are necessary. If
the file is not available in COMBIVIS no parameters are displayed in the editor. By online
update function the database can be actualised automatically.
On the main path the XML-Files of all addressable devices are stored. In addition to the
main path, description files can also be stored in other places (e.g. for test firmware etc.).
The data path must be achieved here as "Additional directory".
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1

Fig. 175: File paths

1 Apply updated files without restart-
ing.

15.10 Options - KEB Scope

Fig. 176: Scope

(≡► Scope Basic Settings [} 251])

15.11 Options - Load and Save
Settings for loading, saving and for the start-window:
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1
2

3

Fig. 177: Load_Save

1 Create an automatic backup copy
when saving the project.

2 Create an automatic backup.

3 Display when COMBVIS is started

The backup is stored as “xxx.backup” and can be made readable again by changing in
“xxx.project”.

15.12 Miscellaneous
In default all tabs in the device editor are directed horizontally. Alternatively, the tabs can
be directed vertically.
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➊

Fig. 178: Miscellaneous_1

➊ Arrange tabs horizontally or vertically
in the device editor.

Fig. 179: Miscellaneous_2



15 | General settings KEB Automation KG

146 ma_mu_sw-cv68-20428970_en

15.13 KEB Wizards

Fig. 180: Options - KEB Wizards

If the operating mode is changed and the inverter is in the "Operation Enabled" state, the
motor can move. This depends on the selected mode and the respective valid paramet-
ers.
This behaviour may surprise inexperienced users.
By selecting the radio button, a warning is displayed in the Testrun Wizard before the op-
erating mode is changed via the drop-down selection. If the user cancels here, the oper-
ating mode is not changed.
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16 Screen layout
Reset screen layout:

All changes of the screen layout can be reset:
Menu bar: "Window" → "Reset Window Layout"

Fig. 181: Reset window layout to default

Change screen layout manually:

The tabs (editor window, scope, parameter list...) can be displayed one below the other or
side by side:
Activate the tab group to be dragged → select menu "Window" → "New horizontal or ver-
tical tab group".

Fig. 182: Screen layout new vertical tab group

Alternative:
Select the tab to be dragged with the left mouse button, hold it down and drag it to the
centre of the screen. An orientation cross appears. Depending on the selection, the tab is
arranged at the top, bottom, right or left (area with blue background).
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Fig. 183: Orientation cross_1

The shifted window can be superimposed on the actual COMBIVIS window. In multi-
screen mode, you can use it to drag the window to another screen. The window is placed
anywhere on the screen with the mouse pointer. To reset it, place it on the middle field in
the orientation cross.

Fig. 184: Orientation cross_2
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Tabs below or next to each other can be dragged to the place next to another tab. So
these tabs are in a row.

The same behaviour when dragging the tab to the center of the orientation cross (see
above).

Fig. 185: Orientation cross_3
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17 Start-up Assistant (Wizards)
Start-up wizards are tools for an easy creating of parameter lists and parameter
adjustments.
Two procedures of start-up wizards can be found:
Online start-up wizards – all adjustments are done directly in the device.
Offline start-up wizards – creates a parameter list, which can be stored or directly
downloaded to the device.
Only the compatible wizards will be offered in the project.
For “generation 5” drives (type F5, B6, G6) online and offline wizards can be found.
For “generation 6” drives (type F6, H6, P6, S6, T6) an online wizard is offered. It
can be used offline partly. At next connection to the drive the values will be trans-
ferred to the drive.

17.1 Online Start-Up Wizard
Online wizards need a connected device because all adjustments are done directly
in the device parameters.

17.1.1 Online Start-Up Wizard COMBIVERT F6/ H6/ S6/ P6/ T6.
For the new “generation 6” drive controller a step by step start-up online wizard is
implemented. It can be used also offline but then not all features can be handled.
The idea is to start-up the drive in simple cases without having knowledge of the
programming structure of the drive.
Depending on the functions available in the device type, parts of the wizard are
masked.
For each function card there is a tab “expert settings”. There, the parameters be-
longing to the respective function are listed directly and allow advanced settings.
The normal user is passed over it and normally does not need to set anything.

➊
➋

➌

Fig. 186: Start-Up Wizard online

➊ Select Wizard ➋ Step by step guidance forward
and backward



Start-up Assistant (Wizards) | 17

ma_mu_sw-cv68-20428970_en 151

➌ Expert mode with the relevant
parameters

Please also watch the tutorial on YouTube:

Here you can find more online tutorials from KEB.

(► https://www.youtube.com/channel/UCf577xwE-
cis-zTqrSAUCVXw)

17.1.1.1 Basic Settings
• Backup/data backup / read back the stored values. The backup is saved with the

project.
• A saved backup file can be exported as parameter list to the navigator and from

there exported out of the project.
• Load factory setting
• In the process, CV loses the connection with the device for a short time, but this

is automatically re-established.
• Process data disabling, save bus settings, reconnect with former adjustments:
• With active process data, the controller can overwrite certain parameters again

and thus make a manual adjustment impossible. This function only works with
COMBIVERT F6-K, S6-K and H6.

• Device clock
The clock has no runtime reserve, also no connection to the clock of the safety
module (option).

1

2

3

4

5

6

Fig. 187: Start-up Assistant (Wizards) Basic settings

1 Create backup. 2 Load backup to the device

https://www.youtube.com/channel/UCf577xwEcis-zTqrSAUCVXw
https://www.youtube.com/channel/UCf577xwEcis-zTqrSAUCVXw
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3 Delete backup, download to the
device or export to the navigator
as parameter list.

4 Set device to default.

5 Disable process data (only F6-K,
S6-K, and H6).

6 Set clock, manually or by PC
clock.

17.1.1.2 Wizard Motor
Characteristics:
• Can be used for synchronous and asynchronous 3-phase motors.
• KEB synchronous motor data can be chosen directly by part no.
• Motor data can be adjusted manually, and the data can be stored in a motor

data base (after identification in window “Identification".
• Motor data is displayed similarly to a name plate and the parameter values are

prepared accordingly.
• In addition to the parameter values, calculated values are also displayed, e.g.

the rated power or the maximum torque.
• Motor data can be loaded from the user database.
• User data base can be loaded or exported.
• Motor brake and sine-wave filter data can be entered optionally.
• The braking transistor can be activated.
• The temperature sensor type and error response can be set.
Leaving of the window “motor” activates the motor data in the drive controller.

17.1.1.2.1 Motor data
The basic motor data is specified on this tab. Motor data can be taken from the fol-
lowing sources:
• KEB motor database
• User database
• Manual input
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Fig. 188: Wizard - Motor - Motor data

17.1.1.2.2 Feedback mode
If the regenerative energy is not fed back into the grid, a braking transistor can be
activated on this register page. The energy is then thermally converted with a con-
nected braking resistor.
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Fig. 189: Wizard - Motor - Generator mode

17.1.1.2.3 Brake control
The control of a brake can be activated and set on this tab.

Fig. 190: Wizard - Motor - Brake control

17.1.1.2.4 Sine filter
This wizard can be used to select sine filter combinations from a drop-down menu.
The "Preview" button can be used to display the parameter values of the selected
data.
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Fig. 191: Wizard - Motor - Sine filter - Preview

Click on  to transfer the parameter values to the "Parameters" selection.
Alternatively, the data can also be entered manually in the parameters.

NOTICE! Changing the Basic TP has a background effect on the cycle times,
the switching frequency and the offline scope (see device instructions).

Fig. 192: Wizard - Motor - Sine filter

17.1.1.2.5 Expert settings
The page shows a selection of the parameters influenced by the motor wizard.
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Fig. 193: Wizard - Motor - Expert settings

17.1.1.3 Feedback mode
• Adjustment of the operating mode and feedback mode (v/f mode, closed loop,

encoder less closed loop)
• Adjustment of the encoder interface, encoder type and values
• At encoders with electronic nameplate, this can be red out (KEB motors)
• At synchronous motors, the v/f mode is not available).
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Fig. 194: Start-up Assistant (Wizards) Feedback mode

17.1.1.4 Controller
• Adjustments for speed controller and position controller.
• Pre adjustments depending on the inertia of motor and machine.
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Fig. 195: Start-up Assistant (Wizards) Controller

17.1.1.5 Wizard Protection / Warnings

17.1.1.5.1 Status word setting

Fig. 196: Wizard - Protection / Warnings - Statusword settings

17.1.1.5.2 Setting the warning levels
Setting the warning level and corresponding behaviour when triggered.
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Fig. 197: Start-up Assistant (Wizards) Protection / Warnings

If you leave the mouse pointer on the corresponding element, the associated para-
meter with name and value is displayed in the tooltip.

Fig. 198: Warning Overload OL warning level

Fig. 199: Warning - Overload OL stop mode
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Fig. 200: Warning - Overload counter

17.1.1.5.3 Application specific warning settings

Fig. 201: Wizard - Protection / Warnings - Application specific warning settings

17.1.1.5.4 Fault reaction ramp mode settings

Fig. 202: Wizard - Protection / Warnings - Fault reaction ramp mode settings
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17.1.1.5.5 Fault reaction ramp value settings

Fig. 203: Wizard - Protection / Warnings - Fault reaction ramp value settings

17.1.1.5.6 Expert settings

Fig. 204: Wizard - Protection / Warnings - Expert settings

17.1.1.6 Identification
• Guided motor data identification/measurement.
• Must not be done at KEB motors selected by KEB motor database.
• Identified motor data can be stored in user motor database.
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Fig. 205: Start-up Assistant (Wizards) Identification

17.1.1.7 Operating modes
Operating modes
Settings for the available operating modes according to CiA 402 e.g.: ramp mode,
s-curves, sped limits, position profiles, homing methods etc.
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Fig. 206: Start-up Assistant (Wizards) Operating mode1
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Fig. 207: Start-up Assistant (Wizards) Operating mode2

17.1.1.8 Wizard Fieldbus
• Selection of bus system
• Process data size
• Process data adjustments
• Bus diagnosis
• Create and export of device description files
• Save and handle of self-created mappings
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Fig. 208: Start-up Assistant (Wizards) Fieldbus

17.1.1.8.1 Selection of the bus system
Depending on the hardware of the device the bus type can be selected.

Fig. 209: Wizard - Fieldbus - Select fieldbus type

17.1.1.8.1.1 CAN Cross
If the wizard recognises that a device is CAN Cross-capable, then
• the selection in the drop-down field is extended accordingly.
• the parameter value of fb73 is displayed in the window.
• the expert settings are expanded to include the visualised parameters for CAN

Cross functionality.

This looks as follows for "CANopen":
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Fig. 210: Wizard - Fieldbus - CAN Cross

The parameters required to set the Can Cross functionality are now visualised
there and can be set directly. This includes the 'Cob-Id' belonging to the respective
send and receive PDO with the sub-parameters 'RTR' and 'TPDO'/'RPDO', as well
as the 'Transmission type' and the 'CAN-ID'.

For 'EtherCAT + CAN Cross' and simultaneously for 'Profinet + CAN Cross' it then
looks as follows:

Fig. 211: Wizard - Fieldbus - EtherCAT CAN Cross

The send and receive PDOs for the CAN cross functionality are displayed below
the (EtherCAT/Profinet) send and receive PDOs.

The relevant parameters are summarised in the expert settings:
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Fig. 212: Wizard - Fieldbus - CAN Cross expert setting

17.1.1.8.2 Process data size
At EtherCAT and Profinet the process data size can be chosen (depending on firm-
ware version).

Fig. 213: Start-up Assistant (Wizards) process data size

If the selected bus system or the process data size is changed, an er-
ror is triggered in the drive (ru01 = Error! fieldbus type changed). The
change must be confirmed by pressing the "run software reset" button
or a power-on reset of the device. Only then will the change be accep-
ted!

Fig. 214: Start-up Assistant (Wizards)

17.1.1.8.3 Assignment of process data
The wizard offers a standard process data assignment:
“Stored Mappings” → “KEB database” → “Load” → select device type. The process
data will be loaded and activated.
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Fig. 215: Start-up Assistant Wizard_load

A customer specific assignment can be stored in the user data base and can be re-
loaded.
“Stored Mappings” → “User database” → “Load/Save"

Fig. 216: Start-up Assistant (Wizards) Stored_Mappings

The user database is saved in the file <Installationsordner>\KEB\PdTemplate-
sUser.xml and can be transferred to other PCs by copying the file.

17.1.1.8.4 Manual assignment
The process data must be disabled!
The right-hand window lists the parameters available for process data.
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These can be copied with the mouse to the Transmit PDO field or the Receive
PDO field using drag & drop. The data length is taken over correctly.
Parameters can be deleted by moving them to the waste bin at the bottom left us-
ing the mouse or by selecting them and pressing the "Remove" button.
"Read-only parameters" cannot be dragged into the Receive PDO field.
The number of transferred objects can be restricted. This allows certain objects to
be excluded from data exchange from right to left.

➊

➋

➌
➍

➍

➎

➎

➏

Fig. 217: Wizard - Fieldbus - Process data mapping

➊ Transmit PDOs (Drive controller
-> PLC)

➋ Receive PDOs (PLC -> Drive con-
troller)

➌ Parameter available for process
data

➍ Number of active PDOs

➎ Enable process data ➏ Waste bin for deleting PDOs

17.1.1.8.5 Device description file
With the wizard, the device description file can be generated depending on the se-
lected bus type. At CAN and EtherCAT, this contains the current process data as-
signment.

EtherCAT EDS:
"EtherCAT" → "Export device description file".

Fig. 218: Start-up Assistant (Wizards) Export device description
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If KEB COMBICONTROL is available, descriptions can be loaded directly to it:

Fig. 219: Start-up Assistant (Wizards) Install to device-repository

For an EtherCAT PLC this can be generated and saved:

Fig. 220: Start-up Assistant (Wizards) Save as EtherCAT-XML-File

The FSOE process data description can additionally be selected for the KEB
Safety Modules: (=> manual of the respective device).
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Fig. 221: Start-up Assistant (Wizards) Safety Module 1

Fig. 222: Start-up Assistant (Wizards) Safety Module 2
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PROFINET
The device description file GSDML can be found in the KEB document database in
the "Software" area under the part number of the COMBIVERT“ or keyword
"PROFINET":

Fig. 223: Start-up Assistant (Wizards) Software

CAN EDS:
In the CAN process data wizard, an EDS device description file can be created and
saved:

Fig. 224: Start-up Assistant (Wizards) CAN EDS
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Ethernet IP EDS:
The EDS device description file can be found in the KEB document database in the
"Software" area under the part number of the COMBIVERT or the term “Ethernet”:

Fig. 225: Start-up Assistant (Wizards) ESD

Powerlink xdd:
In the Powerlink process data wizard, the xdd device description file can be cre-
ated and saved:

Fig. 226: Wizard - Fieldbus - Create Powerlink xdd

EtherCAT + CAN Cross and PROFINET + CAN Cross:
With PROFINET, an EDS device description file can be generated and saved for
CAN. With EtherCAT, additional files can also be created and saved as described
above.
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Fig. 227: Wizard - Fieldbus - CAN Cross

17.1.1.9 Wizard Test run
The Test run wizard opens in a separate window.
It enables a motor run or positioning step from the PC without having a separate
controller. The status of the status machine is also displayed graphically.
The Test run wizard opens in a separate window.

 CAUTION Test run wizard has no watchdog function
If communication is lost due to cable interruption or program crash, the drive
continues to run with its last setpoints!

a) Always create a second possibility to stop the drive. This can be done by a
separate switch for controller enable, STO or mains voltage.

NOTICE Motor runs in the "Operation Enabled" state when the operating mode is
changed!
ü This behaviour is desired, but can surprise users.
a) A warning message can be activated under Tools > Options > KEB Assistant.
b) The user then has the option of cancelling.

The test run wizard can be called up by clicking on the "Start test run wizard" but-
ton. It is then stored in the Navigator for the corresponding device under the wiz-
ards.
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Fig. 228: Start-up wizard Test run starts

The test run can also be added via the context menu using the right mouse button.
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Fig. 229: Add test run in the Navigator
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Fig. 230: Wizard - Start test run

17.1.1.9.1 State Machine
The view for the state machine can be opened with the field "Status display" in the
upper right corner.
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➊

Fig. 231: Wizard - Test run - Open status display

➊ Click here to open the status dis-
play

The state machine graphically displays the state of control word co00 and status
word st00. In the control word, each bit can be set individually by clicking on the
green dots. The direct buttons below can also be used.



Start-up Assistant (Wizards) | 17

ma_mu_sw-cv68-20428970_en 179

Fig. 232: Start-up wizard Velocity mode

17.1.1.9.2 Velocity Mode
Velocity mode:
• Presetting of 4 or more speeds (see ➒)
• Operating the control word
• Brake control bit
• Starting a predefined scope recording
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➊

➋

➌

➍

➎

➏

➐ ➑

➒

➒

➓
Fig. 233: Wizard - Test run - Velocity mode

➊ Display of the current status, such
as STO, error, power supply.

➋ Switch brake - bit 15 in the control
word (parameter co00).

➌ Setting the operating mode (para-
meter co01).

➍ Start / Stop - Enable Operation in
the Statemachine.

➎ Actual speed ➏ Current setpoint
➐ Preset target speeds ➑ Take over target speed in vl20
➒ + Add / - Remove target speed ➓ Start preset scope.

17.1.1.9.3 Profil position mode
The drive can be moved in relative or absolute position profile.
The positioning profile (Profile position mode) is used here:
• Presetting of 3 or more positions
• Operating the control word and status word
• Brake control
• Starting a predefined scope recording
• Set current position to 0 by executing homing method 37
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①

②

③

④

⑤

⑥
⑦

⑧ ⑨
⑩

⑪ ⑫
⑬

⑭

⑮

⑯
Fig. 234: Wizard - Test run - Profile positioning mode

① Display of the current status, such
as STO, error, power supply.
Switching the brake: Bit 15 in the
control word (parameter co00).

② Setting the operating mode (para-
meter co01)

③ Start / Stop - Enable Operation in
the Statemachine

④ Actual speed

⑤ Current position of the drive ⑥ Positioning speed for the next pro-
file (parameter ps30)
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⑦ If the drive has to stand still when
no position is active = enter "0"
(parameter vl20).

⑧ Move to position 0.

⑨ Write predefined target into para-
meter co19 "Target position" and
start positioning.

⑩ Set the current position to 0. Like
homing method 37.

⑪ Predefined target position ⑫ Hook: Relative positioning / No
hook: Absolute positioning

⑬ Hook: The positioning profile is
cancelled and the new target is
approached. / No hook: The cur-
rent positioning profile is ended
and the new target is approached.

⑭ "+" adds another target position

⑮ "-" deletes a target position. ⑯ Start preset scope.

With "relative position" and "change target position immediately = off",
a positioning profile is generated with each mouse click on the field
"Start positioning" and then processed one after the other.

17.1.1.9.4 F5-compatible behaviour
Downward-compatible behaviour is supported in the test wizard. To utilise this, bits
0 and 4 must be set in parameter ud50 [1] option code.
• F5 compatible control word

This is activated via bit 0 = 1.
• F5 compatible setpoint speed 

The alternative speed specification is activated via bit 4 =16). 
If this mode is active, the specification via the "Target Velocity" parameter is ig-
nored in all relevant operating modes (in particular Velocity Mode and Posi
Mode). Instead, the speed is specified with the parameter ud50 [6]. 
The setting is made as a percentage of the reference speed ud50 [13] in the
range of ±100 %. 
The speed is therefore determined using this formula: ud50 [6] / 100% * ud50
[13]

17.1.1.10 Cogging
The cogging compensation function is used to minimise the cogging torque gener-
ated by the permanent magnets at low speed. For this purpose, the wizard meas-
ures a characteristic curve and saves it in the drive.

Fig. 235: Start-up wizard Cogging

• Only applicable for permanent magnet linear motors or permanent magnet syn-
chronous motors!

• The anticogging measurement should only be carried out when the drive control-
lers for speed and position are well adjusted!

• The motor must be able to run load-free.
• Depending on the motor size and type, adjustments to the wizard setting may be

necessary.
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• No values may be changed manually or by the bus system in the drive during
the measurement.

• The wizard uses the Profile position mode for the measurement.
• The calibration takes approx. 20 - 30 minutes.
• After the measurement has been completed, the result must be transferred to

the drive and the function activated.
• The measurement can be cancelled at any time. As long as the measured val-

ues are not transmitted and activated, the drive is not affected.
The mode"Target reached" controls the measurement via the positioning profile
and ensures that really every measuring position is approached. This mode gives
an accurate result, but requires well adjusted speed and positioning controllers.
The mode "Time based" controls the measurement via a temporal sequence of
measurements, regardless of whether the measurement position has actually been
reached or not. The result is somewhat less precise, but it works less problematic-
ally because the movement does not have to be so accurate.
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Fig. 236: Start-up wizard Measuring condition

After the measurement has been completed, the data must be transferred to the
drive controller and activated:
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Fig. 237: Start-up wizard Activate selection

The measurement results are displayed in the "Graphs and data" editor.
The results can be saved in a separate file and can also be called up again.

Fig. 238: Start-up wizard Graphs and Data
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17.1.2 Homing Mode
Set the current position to 0.
In many cases, the current mechanical position of the drive must / should represent
the zero point. This can be achieved by the following setting:
• Set mode to “homing mode”
• The homing method must be set to "35: on current position" (default). The para-

meter hm01 is included in the expert settings:

Fig. 239: Start-up wizard Expert settings

• Enable the bit “Start homing” in the Control Word and disable the bit.

Fig. 240: Start-up wizard Homing m

The other modes cannot be used or only with restrictions by the test run wizard.
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17.1.3 Online Start-up Assistant Basis COMBIVERT F5, B6 and G6.
For all COMBIVERT F5, B6 or G6 a small startup wizard is available.

1

2

3

4

Fig. 241: Online Start-Up Wizard

1 Adjust control and speed mode 2 Set factory default (Fr01 = -4)
3 Copy set 0 / subindex 0 to all

sets / subindices
4 Copy all values of one set / su-

bindex to another set / subindex

17.1.4 Online Start-Up Wizard COMBIVERT F5

17.1.4.1 Calibration of asynchronous motors F5-A/ -K and F5-H/ -L (ASCL)
A wizard for the calibration process is available for the modes for closed-loop oper-
ation of three-phase asynchronous motors with and without encoders. Prerequisite
is a device software F5-A/-M/-K from V4.3 or F5-H/-L from V2.3. There is a stand-
ard mode and an expert mode. Certain device settings that must be changed for
calibration, such as setpoint settings, are saved before starting calibration. The
functional description of the calibration procedure can be found in the F5-A applica-
tion manual ((≡► Document database [} 284])).
It must be possible to open and close the control release terminal as specified dur-
ing the calibration process. Switching via software is not possible.

Open in Device Editor
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1

2

3

4

5

Fig. 242: Start-Up Assistant F5 B6 G6

1 Adjust speed mode 2 Enter motor data
3 Start calibration with automatic

procedure.
4 Display of the current values dur-

ing calibration.
5 Switch on expert mode

With expert mode:

1

2

3
4

5

Fig. 243: Start-Up Assistant F5

1 Open list with manually adjustable
parameters.

2 Full selection of identification op-
tions.

3 Adopt best settings. 4 Manually adaption of filter set-
tings.

5 Expert mode enabled.

In the tab "Expert settings" all relevant parameters are available as an online list
and can be adjusted manually if required such as the parameter editor:
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Fig. 244: Start-Up Wizard Online Wizards Motor ident.

17.1.4.2 Motor Data Identification F5-A/ S/ K and F5-E/ P (SCL)
For driving with PM synchronous motors with and without encoder a wizard for mo-
tor data calculation and measurement is available. It works only with F5-A/ S/ K
from V4.3 or F5-E /P from V2.3. A standard mode and an expert mode are avail-
able. Specific values which are to be changed for measurement (set value…) are
saved before and set back after finishing of the measurement. The description of
the motor identifying function can be found in the application manual F5-A ((≡►
Document database [} 284])).
The control release (terminal 16) must be switched open and close while identify-
ing runs. Switching by software is not possible.
Open in device editor
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1

2

3

4

5

6

Or

Fig. 245: Start-Up Assistant SCL_1

1 Adjust speed mode 2 Adjust motor data manually.
3 Routing to motor data assistant. 4 Start identification with automatic

procedure.
5 Display of actual measured data

or status.
6 Enable expert mode.

(≡► Motor configurator F5-S [} 196])
In expert mode, additional useful functions are offered:

1

2

3

4

5

6

7

Fig. 246: Start-Up Assistant SCL_2

1 Open list with manually adjustable
parameters.

2 Full selection of identification op-
tions.

3 Adopt best adjustments. 4 Manually adaption of filter set-
tings.

5 Stabilises the start. 6 Extra menu for rotor position de-
tection.

7 Expert mode enabled.
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In the tab "Expert settings" all relevant parameters are available as an online list
and can be adjusted manually if required such as:

Fig. 247: Start-Up Wizard SCL_3

17.1.4.3 Start-Up Assistant F5 with PROFINET
Using the wizard for the process data assignment can be done in a simple manner
the PDO assignment. In standard mode, certain parameters of the wizard can be
dragged by "drag and drop" from the Device Editor in the appropriate fields. There
is an operator firmware version 2.9ff required.
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1

Fig. 248: Start-Up Wizard F5 PROFIBUS 1

1 Drag and hold the parameter onto
the "Online Wizard" tab with the
left mouse button pressed.

Fig. 249: Start-Up Wizard F5 PROFIBUS 2

A change can be done only in condition “Inactive PDO”.
In the Expert mode the PDO assignment can be done manually by hexadecimal
addresses.
(≡► Offline Start-Up Wizard [} 193])

see also
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2 Offline Start-Up Wizard [} 193]

17.1.5 Online Start-Up Wizard COMBIVERT G6-L (ASCL) and G6-P (SCL)

Motor Data Identification G6-L (ASCL)
The online start up wizard basically works the same as (≡► F5-ASCL [} 187]). The
functional description of the calibration procedure can be found in the G6 applica-
tion manual (≡► Document database [} 284]).

Motor Data Identification G6-P (SCL)
The online start up wizard basically works the same as (≡► F5-SCL [} 187]).
The functional description of the calibration procedure can be found in the G6 ap-
plication manual (≡► Document database [} 284]).

17.1.6 Start-Up Wizard COMBIVERT T6.
A separate commissioning assistant will be published for the COMBIVERT T6 dur-
ing the term of CV 6.6.0. This is only integrated in COMBIVIS studio 6, since the
start-up works with the integrated embedded PLC.
The “inverter-specific” parameters can be addressed with the online start-up wiz-
ard.
(≡► Online Start-Up Wizard COMBIVERT F6/ H6/ S6/ P6/ T6. [} 150])

17.2 Offline Start-Up Wizard
For an offline Start-up wizard, it is not needed to connect a device.
The result can be loaded directly into a connected device, or a list of data (para-
meter list or another file) can be created, that can be saved and load into the
device later.

17.2.1 Open Start-Up Wizard
If there is a wizard for the device software offered, it will be shown direct in the nav-
igator window.

Fig. 250: Start-Up Wizard Offline Start-up
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If it isn´t shown because e.g., the software mode has switched, the start-up wizard
can be opened manually: Mark device → right mouse key → “Add object” → “Start-
up Wizard”

Fig. 251: Start-up Assistant Offline Start-up object

or: Mark device → Toolbar: Icon  → "Start-up Assistant“
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Fig. 252: Start-up Assistant Offline Start-Up Icon

Fig. 253: Start-up Assistant Offline Start-Up

Give name and "Add"
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17.2.2 Offline Start-up Wizard for COMBIVERT F5
17.2.2.1 Motor configurator F5-S

The motor configurator is available in the operating modes for PM servo motors of
types F5-S, F5-P, F5-E and G6-P. It creates a parameter list with related motor
data based on the KEB synchronous motors or self-defined data. This list can be
stored or direct loaded to the device. Currently only synchronous motors are avail-
able.

The self-defined motors are stored in a separate file. This can be copied to other
PCs:
C:\Program Files\KEB\COMBIVIS_6\KEB\UserMotors.xml
Motor from KEB-database:

1

Fig. 254: Start-Up Wizard Offline Start-Up F5

1 Reduction of list for design,
voltage, speed, pole pair number

Choose motor, e.g. B1SM000-6200:
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1

2

3

4

5

Fig. 255: Start-Up Wizard Offline Start-Up F5 Motor

1 Adjust design of cooling type. 2 Ajust encoder type.
3 Pre-adjustment of speed control-

ler: 2 = strong, 15 = weak (based
on motor inertia)

4 Forward

5 Back

Define your own synchronous motor:
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1

2

Fig. 256: Define_synchronous motor

1 Put motor data into motor lis. 2 Use motor data directly for para-
meterisation.

In Overview it can be chosen if the parameter would be load directly into the device
or if a parameter list shall be created.

17.2.2.2 Process data adjustment

Process data adjustment F5-CAN Bus Operator
The process data assignment for the F5-CAN operator can be created and thus an
XML file. However, a download setting in the device is not possible.
The function of the assistant is like the assistant of G6.

Process data adjustment F5 EtherCAT operator
The process data assignment for the F5-CAN operator can be created and thus an
EDS file. However, a download setting in the device is not possible.
The function of the assistant is like the assistant of G6.

Process data adjustment of F5 PROFINET Operator
Using the wizard for the process data assignment can be done in a simple manner
the PDO assignment. In standard mode, certain parameters of the wizard can be
dragged by "drag and drop" from the Device Editor in the appropriate fields. There
is an operator firmware version 2.9ff required.

By "Upload" the adjustments of the device will be transmitted to the assistant and
displayed.
By "Download" the adjustments of the assistant can be transmitted to the connec-
ted device.
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1

2

3

45

Fig. 257: Start-Up Assistant process data assignment F5 PROFINET Operator

1 Assistant for PROFINET Mapping 2 Pd-Mapping with "Drag&Drop"
3 Enable expert mode. 4 Own data sets can be created,

read or deleted.
5 Load mapping from or into device.

In the Expert mode the PDO assignment can be done manually by hexadecimal
addresses.

Fig. 258: Start-Up Assistant expert mode

A parameter list with the relevant parameters can be generated under the "Over-
view" wizard.

see also
2 Offline Start-Up wizard overview [} 206]
2 Offline Start-Up Wizard for COMBIVERT G6 [} 199]

17.2.3 Offline Start-Up Wizard for COMBIVERT G6

see also
2 Motor configurator F5-S [} 196]
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17.2.3.1 Motor data configurator G6-P
The motor data configurator G6 works in the same way as the COMBIVERT F5-S.
(≡► Motor configurator F5-S [} 196])

17.2.3.2 Process data adjustment CAN version
Using the wizard for the process data assignment can be done in a simple manner
the PDO assignment. In standard mode, certain parameters of the wizard can be
dragged by "drag and drop" from the Device Editor in the appropriate fields.
By "Upload" the adjustments of the device will be transmitted to the assistant and
displayed.
By"Download" the adjustments of the assistant can be transmitted to the connec-
ted device.An EDS file suitable for the device and the PDO assignment is gener-
ated with "CAN EDS" .

Fig. 259: Start-Up Assistant process data assignment CAN version

A previously saved setting or the KEB default setting can be loaded into the wizard
with "Configuration database". The KEB default setting loads the assignment for
the CiA 402 profile into the wizard. With "Save" you can save your own assign-
ment.
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Fig. 260: Start-Up Assistant process data assignment CAN version database

In expert mode, the PDO assignment can also be done manually with the hexa-
decimal addresses.
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Fig. 261: Start-Up Assistant process data assignment CAN version PDO 1
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Fig. 262: Start-Up Assistant process data assignment CAN version PDO 2

A parameter list with the relevant parameters can be generated under the Assistant
Overview.

Process data assignment EtherCAT version
The PD assignment can be made in a simple way with the process data assign-
ment wizard. Certain parameters can be dragged and dropped from the device ed-
itor into the corresponding fields of the wizard.
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1 2 3 4

Fig. 263: Start-Up Assistant process data assignment EtherCAT version

1 View Assistant for EtherCAT Mapping 2 Pd-Mapping with "Drag&Drop"
3 Load mapping from or into device. 4 Own data sets can be created, read or deleted.

• The current settings of the connected device are transferred to the assistant with
"Upload".

• The wizard setting is transferred to the connected device with "Download".
• XML or ESI files can be created which are corresponding to the device and the

PD assignment with "Device Descriptions".

Fig. 264: Start-Up Wizard EtherCAT Export
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5

Fig. 265: Start-Up Wizard EtherCAT Export files

1 Create XML-File 2 Create ESI-File
3 Created MDP-File 4 Install in device memory (only with

COMBIVIS studio 6)
5 Save as external file

Detailed setting of the Pd mapping is possible under "PdIn Details" and "PdOut De-
tails".

Fig. 266: Start-Up Assistant EtherCAT Pdln Details

17.2.4 Offline Start-Up wizard COMBIVERT F6/ H6/ S6/ P6/ T6.
There are no Offline wizard for COMBIVERT F6 /H6/ S6/ P6/ T6. The Online wiz-
ard can also be used offline to a limited extent.
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17.2.5 Offline Start-Up wizard overview

1

234

Fig. 267: Start-Up wizard overview

1 Select which parameters of which wizard shall
be included into the list.

2 Load the parameters of the selected wizards
into the device.

3 Creates and exports parameter list with all se-
lected wizards.

4 Generates parameter list with all selected wiz-
ards.
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18 Parameter lists

18.1 Properties
• Parameter lists can be attached to projects or to devices
• Parameters of different devices can be stored in one list and can be uploaded or

downloaded in parallel
• Online and offline data will be indicated in the list at the same time
• Direct or indirect set addressing or addressing according to CiA 301 of the para-

meters
• “Drag and drop function” for parameters from the device editor
• Direct shifting/copying of parameters between editor and parameter list
• Attached parameter lists will be saved with the project
• Export / import of “.dw5” and “.wr5” lists (=COMBIVIS 5)
• Printer functions
• Parameters can get user-defined names
• Parameter lists can be exported individually in COMBIVIS 6 or COMBIVIS 5

format
• Parameter lists can be compared with actual device adjustments or with other

parameter lists
• Online and offline values can be compared directly
• Upload or download history
• Export as recipe directly to the COMBIVERT
• Export as EtherCAT CoE startup command file

If only an existing parameter list may be loaded to the KEB COMBIVERT, the func-
tion “Download parameter list“ on the start page can be used.
(≡► Download of a parameter list [} 98])

18.2 Open a blank list
Attach a parameter list to a device or project: Mark device or project → in tool bar
click on icon "Add parameter list“ → give new list a name → “Add”“

Fig. 268: Open a_blank list

or:
Mark device in the navigator with right mouse key → “Add parameter list“.
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Fig. 269: Add parameter list

Choose a name for the list and “Add“
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Fig. 270: Give list_a name

Alternative:
Right-mouse-key → choose “Add Object” → “KEB Parameter list…” → give list a
name → “Add”

or:

In tool bar click on icon  → "KEB parameter list…“ → give list a name →
"Add“.
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Fig. 271: Add parameter list_object
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Fig. 272: Give list_a name

18.3 Open list with marked parameters
When some parameters are marked, a new parameter list can be opened by con-
text menu: “right mouse key” → “Create parameter list from selection”.
With key “shift” and “Ctrl” several parameters in different groups can be marked at
the same time. But all used groups must be opened before marking the paramet-
ers.
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Fig. 273: Create parameter list from selection

18.4 Open existing list
Parameter lists in "cvxpl"= COMBIVIS 6 format / "dw5" = COMBIVIS 5 format and
work lists in "wr5" = COMBIVIS 5 format can be opened.

Parameter lists can be opened at an empty project. The matching device will be
added automatically in offline mode.

Attach a parameter list to a device or project: Mark device or project in the navig-
ator → in tool bar click on icon "Add parameter list“ → Set check mark at "Import
parameter list" → select file → "open“ → “Add”“

Fig. 274: Open Icon existing list

or:
Click with right mouse key on device → “Add new parameter list“.
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Fig. 275: Add parameter list

Click on "Import parameter list from file" → navigate to the location → select file:
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Fig. 276: Import_file

Fig. 277: Select_file

Next step:
The parameter list is appended to the device at which the dialog was opened. But it
can also be chosen whether it is hung on another device in the project or on a vir-
tual device, which has the same type as the one with which the list was created
earlier.
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1
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3

Fig. 278: Parameter list_device

1 Type and Firmware version of ori-
gin device / parameter list.

2 New device: a new device with
matching type and will be add to
the project (offline). Assign to ex-
isting device: parameter list will be
added to a device of the project.
No check of compatibility.

3 Selection of the device to which
the list is to be assigned. The
Firmware ID (Config-ID) is com-
pared between list and device: or-
ange=different.

If there are parameters of several devices in the list (only at .cvxpl lists), it can be
chosen which device of the list will match which device in the project.
The open parameter list is displayed in the editor.

Fig. 279: Open Icon existing list

Open parameter list without open project:
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A stored parameter list can be opened directly from Windows Explorer by double
click or with button “Open parameter list” on COMBIVIS start page. A temporary
project will be created in background.

Fig. 280: Open parameter list

18.5 Create complete list
Open choice box by click with right mouse key on the respective device → Choose
“Create complete list” → A parameter list with all device parameters will be created.

Fig. 281: Create complete list
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This complete list is filled in column “offline” with COMBIVIS-default
values and does not include yet the actual values of the device. For
data storage it is essential to take an upload from the device before
saving.

18.6 Layout of parameter list
1 2 3 4 5

Fig. 282: Parameter list_Editor

1 Fading out description 2 Area for notes
3 Origin Config-ID of the paramet-

ers
4 Time stamp of modification, Up-

load or Download
5 Basis Config-ID of devices in this

parameter list

1
2 3 4 5 6 7 8 9 10 11 12 13 14

Fig. 283: Layout_parameter list

1 Line number 2 Device reference
3 Reference of device: not shown in

default adjustment.
4 Parameter address (hex)

5 Subindex address 6 Set address
7 Write / read permission 8 Parameter ID
9 Parameter name 10 User-defined name of parameter,

changeable, not shown in default
adjustment.

11 Parameter value (offline) 12 Actual parameter value in device
(online)

13 Notes area 14 Online-indicator

In the subindex and set column is only one value shown, depending on the valid
addressing mode for this parameter.

see also
2 KEB Parameterization - Parameter lists [} 141]

18.6.1 Display of columns in the parameter list:
The columns which may be shown can be chosen by pulling up and close with
mouse or: “right mouse key” → “columns” → “set hook”.
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Fig. 284: Parameter lists_columns

The columns "Device name" and "User-defined name" are switched off in the fact-
ory setting.

18.6.2 Display grid lines:
The grid lines can be activated by: “right mouse key” → “Advanced” → “Display
grid lines”.
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Fig. 285: Display grid lines

18.7 Self-created parameter list
Open blank list ((≡► Open a blank list [} 207])) → mark and copy the parameter in
the device editor → insert into the parameter list. Or: copy with Ctrl+C and paste
with Ctrl+V.

Fig. 286: Self-created parameter list 1
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Fig. 287: Self-created parameter list 2

“Copy” command: the selected parameters are copied in the clipboard.
“Copy (extended)” command: the selected parameters plus the underlying su-
bindices or set programmable parameters are copied in the clipboard.
Alternatively:
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Fig. 288: Parameter list alternative

Place device editor and parameter list window beside each other ((≡► Screen lay-
out [} 147])) → mark the parameter in the device editor with left mouse key → hold
the key → pull the parameter into the parameter list (Drag&Drop).

18.8 Insert an empty line
To insert an empty line “right mouse key” → “Insert empty line“.

Fig. 289: Parameter list Insert empty line

Empty lines have no influence. They are used only for structuring.
Comments can also be inserted in empty lines.

18.9 Transfer pause during download
A transfer pause stops the download of the parameter list to the device in this line.
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A pause can be inserted for an adjustable time or a pause can be inserted until an
"OK" command is entered. The process is defined by a number in the offline value
field.

Fig. 290: Insert parameter list pause

18.9.1 Transfer pause during download to device:

Offline value "minus xx milliseconds“
The time is counted down. The remark text will be shown. After expiration the
download is continued automatically, e.g. -2000 ms = 2 sec. wait.

Fig. 291: Parameter list waiting time

18.9.2 User input (confirmation):
Offline value: (+) xx ms: Unrestricted pause and display of the remark text, con-
tinue after "OK".
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Fig. 292: Parameter list waiting time (confirmation)

18.10 Changing of device reference
The device reference shows from or to which device the parameter value is read or
written during upload or download.
A change can be made by "double-clicking with left mouse button" on the DRef.
number (device reference). Changing multiple GRef. at the same time can be af-
fected by:
Marking of the corresponding lines in the column “GRef” → “right mouse key” →
“Edit Device-Reference” → choose new device reference → “OK”.

Fig. 293: Parameter lists changing of device reference

18.11 Upload from device into parameter list
Definition: with "Upload" is meant the reading of data from the KEB device into
COMBIVIS.

 WARNING Unexpected drive movement
Open the control release or the STO inputs before upload, because at upload
some pointer can be changed. Especially when values are written by bus
system at the same time an unexpected moving of the drive can occur.

Carrying out the upload into an opened parameter list:

• Click on icon  in the tool bar, or:
• Click right mouse key in the parameter window, choose “Upload list”, or:
• Tap key “F5”
and answer the following questions with “Yes”.
The column “Offline value” will become overwritten with the values (online values)
which are adjusted in the device.
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Fig. 294: Parameter lists Upload of the list

Be sure that the device reference in the list matches the target device
´s reference. Otherwise adapt the reference of the list (≡► Changing
of device reference [} 223]).

18.12 Parameter Download
Definition: with "Download" is meant the transfer of data from COMBIVIS to the
KEB device.

 WARNING Uncontrolled drive movement
Open the terminal control release or the STO inputs before download of para-
meter list into the device. Because some parameters can be written only at
open control release terminal. And an unexpected moving of the drive can
occur.

If only one existing parameter list is to be loaded into a KEB COMBIVERT, the
function "Download of a parameter list" can be used on the start page ((≡► Down-
load of a parameter list [} 98])) .
Carrying out the download of an opened parameter list:

• Click on icon  in the tool bar, or:
• Click right mouse key in the parameter window, choose “Download List” or:
• Tap key “F4” and answer the following questions with “Yes”.
The values, which are adjusted in the device, will become overwritten with the val-
ues of the column “Offline Values”. Only the writeable parameters which are in the
list will get overwritten. All the rest will remain unaffected.
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Fig. 295: Parameter lists Download of the lists

Be sure that the device reference in the list matches the target device
´s reference. Otherwise adapt the reference of the list ((≡► Changing
of device reference [} 223])).

18.12.1 Parameter download from a parameter list to several devices:
Parallel up/download from/to several devices (here: DRef 0 and 1) from a list is
possible. Each parameter is dedicated to one device. Therefor the suitable target-
Config-IDs must be registered. Missing Config-IDs will be added at up/download
optionally.

Fig. 296: Parameter lists Download parameter list

Parameters can be excluded from downloading if they are set in the R/W column to
"Read only".
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Fig. 297: Parameter lists Exclude Download

18.13 Renaming parameter list
Double-click slowly in the navigator on parameter list’s name and rename. Confirm
with "Enter".

Fig. 298: Renaming parameter list
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18.14 Comparing parameter lists directly
Online and offline values can be compered in a parameter list directly by context
menu: Right mouse key → “Advanced” → “Enable quick-compare”
In column “Online value”:
• Green: Online / offline values equal
• Red: Online / offline values unequal
• Yellow: Parameter not existing

Fig. 299: Parameter lists Extended Quick-compare

If the parameter list is designed with indirect set pointer, all paramet-
ers in all sets will be compared only with 1 set (the set to which the set
pointer Fr09 is adjusted). For an expedient comparing use direct set or
CiA 301 addressing for the parameter list ((≡► Parameter backup
[} 232])).

For parameters whose values are displayed online (in the device) by pointer setting
(e.g. Ud16, Ud22, In24 ...), the value listed in the offline list by different pointer set-
tings is always compared online with the same value designated by the pointer;
e.g. at COMBIVERT F5, B6, G6: Ud16…).
Example:
Ud15 (CP-selector) is the pointer for Ud16 (CP-Address). In Ud15 one of 36 pos-
sible parameters and in Ud16 the related (application) parameter address can be
chosen. Ud16 contains the parameter and Ud15 the place in the CP menu where it
displays its value. In a data saving list all 36 Ud15 and Ud16 must be listed, but on-
line, in the device. Ud15 shows every time the same value. That gives at compar-
ing once an equal and 35 times an unequal value.
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Fig. 300: Parameter lists Quick-compare CP Parameters

18.15 Comparing parameter lists
A parameter list can be compared with an actual device adjustment or with the off-
line values of another parameter list:
Find by context menu - right mouse key → “Compare parameter list”

Fig. 301: Comparing parameter lists

18.15.1 Online comparison
Comparing of a parameter list’s offline values with actual online values in a device
generates a new parameter list with the different values of the device. The values
of the parameter list are shown also in the offline column in the new difference list.
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1

2

Fig. 302: Parameter list online comparison

1 If the device reference of the
device and the list are different,
this can be ignored.

2 Unused set pointers and index
parameters are not displayed.

18.15.2 Offline comparison
Comparing of a parameter list’s offline values with another offline parameter list
creates a new list with the unequal values of the 2nd list.

1

2

Fig. 303: Parameter list comparison

1 If the device reference of the
device and the list are different,
this can be ignored.

2 Unused set pointers and index
parameters are not displayed.

18.15.3 Comparison method

There are two different comparison methods:
Line-by-line comparison mode:
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The comparison is made line by line without considering the meaning. Blank and
pause lines can be faded out. This procedure works when comparing two identical
parameter lists at different values. Par example a data backup before and after a
change.

Only the values in the same lines will be compared, independent
which parameter is in this line! Displacements in the list, e.g., by addi-
tional parameters will cause in a wrong result!

"Advanced Diff algorithm":
Compares the contents of two parameter lists with a diff. algorithm and presents
the differences. This algorithm is able to find both inserted and removed entries.

This mode identifies groups of parameters which are in the same line on both lists.
A comparison of differently structured lists (e.g. indirect vs. direct addressing) is not
possible! It is adjustable which columns shall be compared.
The result is shown in a separate window. A new parameter list can be generated
from this.

1

Fig. 304: Parameter list comparison method

1 Columns to be compared
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1

2

3

4

5

Fig. 305: Parameter list comparison method properties

1 Generates a parameter list with
the selected properties.

2 White: parameters with same ad-
justments.

3 Yellow: parameters with different
adjustments.

4 Grey: Parameters missing.

5 Green: Parameters only available
in this list.

18.16 Convert addressing of parameter lists
With this command the addressing mode of a parameter list can be changed. E.g.,
a set addressed list into a list with subindex addressing/CiA 301 and vice versa.
Also, an indirect addressed list can be changed to direct addressing.
Context menu / Right-click in the parameter list: "Convert list“

Fig. 306: Parameter list conversion
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1

2

3

4

5

Fig. 307: Parameter list conversion

1 Current addressing mode of list 2 Addressing mode after conversion
3 Mark if ARRAY parameters are in

the list
4 New additional list with result

5 Overwrite the current list

18.17 Parameter backup
A parameter backup is useful after the completion of the machine function or be-
fore a planned change of the setting. If necessary, the functionality of the axis has
then been saved for a later device replacement.
The parameter backup generates a parameter list in the project. This can be expor-
ted.
In the wizard for the F6 / H6 / S6 / T6 / P6 there is also the backup function. This
generates a backup file, which can be converted to a parameter list in the project
((≡► Basic Settings [} 151])).
For all KEB COMBIVERT:
Open → "Tools“ → "Parameter Saving“.
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Fig. 308: Parameter lists Tools Parameter backup

➊ ➋ ➌

➍
➎ ➏

➐

➑

➒

Fig. 309: Parameter backup - Lists

➊ Select the devices whose para-
meters are to be saved.

➋ Selection of whether device and/
or operator parameters are to be
saved

➌ Selection of how parameters are
to be addressed. Sorting takes
place accordingly (see sorting
mode).

➍ When selected, only devices that
are online appear in the list.

➎ All parameters of the selected
devices are saved in one list. This
is positioned in the Navigator at
the project. The distinction is
made by the device reference.

➏ A separate list is created for each
selected device. This is positioned
in the navigator at the respective
device.
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➐ The separate lists are saved out-
side COMBIVIS as parameter lists
in “.dw5” format.

➑ The pattern for the names of the
generated objects or files can be
configured using the selection
fields for separate lists.

➒ Upload starts. Observe any warn-
ing message. Cancellation is pos-
sible at any time.

After the start a message can be shown:

Fig. 310: Parameter lists Upload starts

Explanation:
If "WA" parameters are included in the list, the upload should not be started if data
is being written to the COMBIVERT at the same time by a bus system or other par-
allel communication. During the upload, pointers to memory cells must be adjusted.
If information is written via this pointer at the same time, it may end up in a wrong
cell. This could be, for example, a wrong target position. After the backup is fin-
ished, all pointers are back in their original position.
The lists can be exported from the navigator (≡► Export parameter list [} 237]).

18.17.1 Sort mode

Depending on the type of the COMBIVERT not all addressing modes are available.
Parameter list design with indirect set addressing:
Design of the list:
Set pointer Fr09 = 0
All set programmable parameters of set 0 and all not set programmable paramet-
ers
• Set pointer Fr09 = 1
All set programmable parameters of set 1
…..
• Set pointer Fr09 = 7
All set programmable parameters of set 7
• Operator parameters
If the drive controller works in contouring mode (synchronous bus mode) the indir-
ect set addressing must be used!
Parameter list design with direct set addressing, joined parameters:
Without set pointer, each parameter belongs direct to one set or several sets.
Design of the list:
• Parameter X of set 0
• Parameter X of set 1
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• Parameter X of set 2
• Parameter X of set 3
……
• Parameter X of set 7
• Parameter Y of set 0
• Parameter Y of set 1
• Parameter Y of set 2
• Parameter Y of set 3
……
• Parameter Y of set 7
…….
• Operator parameters
All not set programmable parameters are written in set 0.
At subindex / CiA 301 addressing “joined parameters” is used always.

Parameter list design with direct set addressing, joined sets:
Without set pointer, each parameter belongs direct to one set or several sets.

Design of the list:
• All set programmable parameters of set 0 and all not set programmable para-

meters.
• All set programmable parameters of set 1
…..
• All set programmable parameters of set 7
• Operator parameters

18.18 CP Parameters
CP parameters are parameters displayed in the device display at COMBIVERT F5,
B6, and G6 in a separate menu. The CP parameters show selectable application
parameters.
In COMBIVIS 6 there is no actual CP parameter menu. Parameterisation is only
possible via the application parameters.
A list can be created which shows the assignment of CP parameter and application
parameter.

→ Click with right mouse key on the device in the navigator → “Create CP para-
meter list”.
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Fig. 311: Parameter lists Create_CP parameter list

Fig. 312: Parameter lists CP parameters inverter state

In the column “#” the number of the CP parameter is shown. The parameter is the
assigned application parameter. For example, in the picture above: CP03 shows
“ru00 inverter state”.

The assignment of the CP parameter is read out while creating the list.
A subsequent change in the device is not reflected in the list. A scaling
or set assignment is not considered.
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18.19 Export parameter list
Basically, lists attached to the project are saved with the project.
A parameter list can be exported from the project into following formats:

“dw5”= COMBIVIS format - only 1 device in the list
“cvxpl”= COMBIVIS format – several devices in the list
“wr5”= COMBIVIS format – work list
EtherCAT CoE startup command file

A “wr5” list does not store any values, just a list of (online) parameters!

Parameter lists to be used on COMBICONTROL C6, F5 LCD operator
or F6 operator must be stored in "dw5" format.

Export:
Select parameter list in Navigator → right-mouse-click: „Export“ → select storage
format → select storage location.

Fig. 313: Save Parameter lists Export

Alternatively, from open parameter list: right-mouse-click→ Export → select format:
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Fig. 314: Save Parameter lists Export variants

A parameter list can also be exported to an EtherCAT compatible XML format. This
list can be transferred, for example, as a start-up list to an EtherCAT compliant
PLC (COMBICONTROL C6, TwinCAT 3.x).
Select parameter list in Navigator → right mouse click → Export → EtherCAT CoE
startup command file.

Fig. 315: Save parameter lists Export EtherCAT
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19 Scope

19.1 Properties
• Running of one Scope per project possible. Several scopes files can be added and dis-

played.
• Scope files can be attached to the project or to devices.
• Scoped files are saved with the project when it is saved.
• Up to 16 channels per scope from different devices.
• COMBIVERT F5 / B6 / G6: Up to 4 channels per device operate in fast scope mode.

Possible combinations (2x32-bit + 2x16-bit) or (1x32-bit + 3x16-bit) or 4x16-bit para-
meter length.

• COMBIVERT F6 / H6 / S6 no fast Scope mode up to firmware version 2.0.From ver-
sion 2.1 up to four 32-Bit parameters can be used in fast Scope mode (Service 21).

• Display as dot, line, step curve or interpolated curve.
• It is possible to record channels in all devices of the project at the same time.
• Export in XML format with file extension ".sc6" for import into another COMBIVIS 6 pro-

ject.
• Export to Excel-compatible ".CSV" format.
• Offline mode (4 channels buffer in one device).
• Online trigger mode ("freeze" on certain condition).
• 2 horizontal and 2 vertical cursors simultaneously.
• Extensive zoom functions.
• Autoscaling function (distribution of curve values over the X and Y axes).
• Unit axis with the unit of the parameter value.
• Import of ".sc5" scope files from COMBIVIS 5 not possible

19.2 Add scope to the project
Following possibilities are offered for to add a scope:
• a new, empty scope
• an external scope with file extension “.sc6” or “XML”
• a scope with the same settings as an existing one.

19.2.1 Add a New Scope

Add Scope: Click on the icon in the toolbar.

Fig. 316: Add a new scope
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Select whether the new scope is to be attached to the project or a device:

Fig. 317: Add Scope

Enter the name of the new scoped file → Add
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Fig. 318: Scope Name
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Fig. 319: Open Scope alternatively

Open the first and further scopes: In the Navigator, highlight the project name, device
name or scope folder under the project or device → "right mouse button" on the project →
"Add object" → "COMBIVIS Scope"
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Fig. 320: Scope Add Object

or in the toolbar: Icon „Add Object“→ „COMBIVIS Scope“

Fig. 321: Scope COMBIVIS Scope

Only one scope can be active at the same time. With each scope, a recording can be
saved in the project. The channels, formats and settings can be different in all scopes.

19.2.2 Open an external Scope
External stored scopes can be opened in a current project or directly with a temporary
project.

Insert into an open project: Click on the Icon  in the toolbar.

Fig. 322: Add a new scope

Select whether the new scope is to be attached to the project or a device:
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Fig. 323: Open Scope

Set hook at import from file → choose the file → „Add“
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Fig. 324: Scope Import from file

Fig. 325: Scope clipboard

→ Choose to which device the scope channels shall belong → "Add"
Selection “New device” adds a new virtual device to the project. This is necessary if there
are no devices or only non-compatible devices in the project.
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Fig. 326: Assign Scope and Add

Different channels in the opened scope can belong to different devices of the project.



Scope | 19

ma_mu_sw-cv68-20428970_en 247

Fig. 327: Scope device selection

The version of the COMBIVERT is stored in the scope, so at opening it is pre-selected if
a matching device is found in the project.
Directly with temporary project in background:
Choose scope file in Windows Explorer, then double-click or in context menu “Open
with….”.
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Fig. 328: Scope output file

On Start Page with button “Open Scope”

Fig. 329: Open scope file

19.2.3 Create scope with same settings
After changing settings in the device, it is useful to make a before-and-after comparison.
For this, you can create a copy of the scope. This can then be used to record a second
scope. This saves a new channel assignment and new adjustment settings.

Copy scope:
By “copy” and “paste” in the navigator, it is easily possible to create a similar scope.
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Fig. 330: Copy scope

Fig. 331: Paste scope

19.2.4 Moving scope in the project
A scope can be moved in the project with the mouse pointer. E.g., from the drive to the
project or from one drive to another. The channel assignment is adjusted automatically.
Note! A warning is displayed if the device reference (Gref) of the scope channels does
not match the device where it was inserted.
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Fig. 332: Move scope file

The assignment of the channels can be adjusted in the settings of each channel.
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Fig. 333: Scope_assignment

19.3 Scope Basic Settings
It is possible to configure basic setting in window KEB Scope-Settings. These adjust-
ments will be preset always when a new scope will be opened.
Menu bar → “Tools” → “Options” → in window “KEB Scope-Settings”
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Fig. 334: Scope Tools Options

Fig. 335: KEB Scope Display Channels Advanced

In window „Settings“ in scope itself settings can be adjusted which are valid only for this
scope.
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Fig. 336: Scope Settings

1 Description for scope 2 Online (direct display of recorded
values in CV6) / Offline mode (see
there)

3 Display / design of cursor, grid and
legend

4 Trigger option (Identification of spe-
cial occurrences in recording – see
there)

5 Time gap between two measured
points: 0 = shortest time

6 Limitation of communication

7 Cursors snap into measured value

Limitation of communication / scan time:
Lock channels:
The specified parameter on a channel can be accessed and queried only by Scope.
Other parameters are accessible.

Exclusive communication:
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All communication with the devices is limited to the scope. Simultaneous change of a
parameter is not possible (Also the test run wizard of the x6-devices no longer works).
At disabled function parameters can be adjusted while scope is running and displays
changes coevally (e.g., for speed controller adjustment).
In the default setting (both functions off), the communication is split between the read-out
scope channels and all device parameters visible in other windows. The scope scan rate
is therefore faster if all editor windows are hidden.

19.4 Channel allocation / New Channel
In window “New Channel” a parameter can be chosen directly for this channel.

1

2

3

4

5

6

7

Fig. 337: Scope New Channel

1 Device reference (selection) from
which device the channel shall be re-
corded

2 Control data of the device

3 Parameter group selection 4 Parameter selection
5 Set selection mode (indirect e.g. for

contouring control)
6 Set or subindex selection

7 Transfer and activation of the chan-
nel

Alternative:
Arrange windows next to or on top of each other. Select parameter in device-editor and
pull it to the window “scope”. (Doesn´t matter if scope is in tab “display”, “settings” or “new
channel”).
Please do not forget acceptance and activation!
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Fig. 338: Scope device parameters

At COMBIVERT H6/ F6/ S6/ P6/ T6 up to firmware 2.7, the index values of
ARRAY and STRUCT parameters cannot be recorded. This function is only
possible at COMBIVERT F6/S6 from firmware version 2.8.

19.5 Setting occupied channel
The settings of the display can be changed at any time, even subsequently.



19 | Scope KEB Automation KG

256 ma_mu_sw-cv68-20428970_en

1 2 3

4

5

6

Fig. 339: Scope Setting occupied channel

1 Channel number 2 Channel switched on/off
3 Optional description 4 Delete channel
5 Display channel allocation: Device /

Parameter
6 Change channel allocation

A disabled (not "enabled") channel is not shown in the display and not recorded at the
next recording.

Scaling of this channel:

1
2

3

4

5
6
7

Fig. 340: Scope Channel switched off

1 Parameter value at 0% Y-axis 2 Parameter value at 100% Y-axis
3 Benchmark at 10% of Y-axis (corres-

ponding to 0 % / 100)
4 Reset to original values

5 Auto scaling of this channel 6 Synchronise with another channel
(e.g. setpoint and encoder speed)
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7 Show unit-axis

1

2
3
4
5
6

7
8
9

Fig. 341: Scope display

1 Display of curve 2 Display in points
3 Display as line, linear connection

between points
4 Display as stairs between points

5 Display as line, interpolated connec-
tion between points

6 Interpolation value

7 Measurement value point highlighted 8 Color of curve
9 Width of curve

19.6 Fast scope mode
The fast Scope mode depending on the device type is a possibility of fast and simultan-
eous transmission of measured values. It works like a process data communication.
COMBIVERT F5/ B6/ G6: Up to 4 channels per device operate in fast scope mode.
(2x32-Bit + 2x16-Bit) or (1x32-Bit + 3x16-Bit) or 4x16-Bit parameter length. The order
does not matter.
COMBIVERT F6 / H6 / S6: no fast Scope mode up to firmware version 2.0. From version
2.1 up to four 32-Bit parameters can be used in fast Scope mode (Service 21).
Typically, the first chosen channels are placed automatically in fast Scope mode if it is
available.



19 | Scope KEB Automation KG

258 ma_mu_sw-cv68-20428970_en

An assignment of parameters outside the fast Scope mode leads to a considerable slow-
down in the recording raster because a time gap must be offered for the additional asyn-
chronous values.
The fast Scope mode works only in direct addressing mode.
The assignment can be changed in menu “channel” → “extended” → “Edit fast scope
mode settings”:

Fig. 342: Scope communication settings

19.7 Recording
Start recording in window “Display” as follows:
Menu: “Scope” → “Start scope”
• or Context menu / right mouse key → “Start scope”
• or Tap key “F9”
• or click on symbol in the toolbar



Scope | 19

ma_mu_sw-cv68-20428970_en 259

Fig. 343: Recording scope

Stop with same functions but a stop-icon will be shown:

Fig. 344: Stop scope

Starting and stopping the scope also works when the scope is not in the foreground.
Recording time is not limited. Per hour with 4 channels at 15ms cycle time the size will be
approx. 90 MB.

19.8 Display window
Behaviour of the display while recording:
Context menu / “Right mouse key”→ “Auto-Zoom/Scroll”:



19 | Scope KEB Automation KG

260 ma_mu_sw-cv68-20428970_en

1

2

3

Fig. 345: Scope Display window

1 Saves the current Y-axis proportion-
ing for a new recording.

2 At recording the displayed window
jumps with the recorded value to the
next window width.

3 The window runs synchronous with
the actual recorded value.

19.9 Adapt Display
Time axis (X-axis):

1

2

34

Fig. 346: Scope Display Operation

1 Stretch / compress time axis 2 Showing / hiding the cursor value
table

3 Complete recording time is displayed 4 Shift window left / right

X-axis:
Recording time in ms or µs
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Y-axis:
Parameter value in basic setting refers to: 100% = maximum value range 0% = 0
-100% = min. value range

By passing the curve with the mouse, the actual value will be displayed.

Fig. 347: Scope measurement curve values

By right mouse key click on the curve a window opens with adjustment possibilities.

Fig. 348: Scope Measurement curve Alignment
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19.9.1 Distribution / stretching of all curves over the display area:
Click with “right mouse key” in the display window: “Auto–scale all channels”
All actual values will be stretched on the Y-axis all over the window from -100% to
+100%.

Fig. 349: Scope Measurement curve Auto scaling

19.10 Display – Zoom
At zooming the relation between the curves is kept.

19.10.1 Zoom to display 0-100% (or rather -100- +100%):
Context menu “Right mouse key” → “Fit Zoom level” → “All axes” (or only “X- or Y-axis”)
Tab key F5 (F3 / F4)
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Fig. 350: Scope Zoom Level

Zoom by mouse:

1

2

Fig. 351: Scope Zoom

1 Mark whole image with mouse wheel
or "+" and "-" keys - Mark partial
area with left mouse button, open
window

2 Time axis: click and hold with mouse
and scroll to right or left side

• Whole display with mouse wheel or keys “+” and “-“
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• The view in the window can be displaced by using the buttons “← ↑ → ↓”
Or
• Tap key “Ctrl” and left mouse key in parallel“
Or
• With pressed mouse wheel
Or
• the buttons in the field:

Fig. 352: Scope measurement curve Keys

19.10.2 Scaling / fixing of Y-axis:
Zooming will be done only at the time- (X-) axis by mouse.
Point to the Y-(%-) axis → context menu / “right mouse key” → “Scale fixed”



Scope | 19

ma_mu_sw-cv68-20428970_en 265

Fig. 353: Scope Measured curve Fix scaling

Also, a manually scaling of the Y-axis can be done.

19.11 Display – Cursors
There are 2 vertical and 2 horizontal cursors:
To integrate: “Right mouse key” → “Cursors” → “Vertical 1 or 2 and horizontal 1 or 2".
Alternative with keys:
• Alt+A: Vertical 1
• Alt+B: Vertical 2
• Alt+C: Horizontal 1
• Alt+D: Horizontal 2



19 | Scope KEB Automation KG

266 ma_mu_sw-cv68-20428970_en

Fig. 354: Scope Cursors

The cursors will always be first placed in the centre.
The cursor can be moved by pressed left mouse key or by using key combination “Alt+→”
and “Alt+ arrow key right”.
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1

2

3

4

Fig. 355: Scope cursor table

1 Cursor vertical 1/2 2 Cursor horizontal 1/2
3 Cursor table visible / invisible 4 Cursor table: Values of the current

horizontal cursor position (Y-axis) or
of the intersection point of the ver-
tical cursor position with the meas-
urement curve

Calculation mode:
Based on vertical cursor values, it is possible to realize several calculation types: differ-
ence, integral or average.
On basis of horizontal cursor values only difference is possible.
By context menu / “right mouse key” in the cursor list area the calculation mode can be
chosen.
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Fig. 356: Scope Measurement curve vertical horiziontal

Or for changing click onto the name with left mouse key.

Fig. 357: Scope Measurement curve Difference values

Fig. 358: Scope Measurement curve Integral values
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Fig. 359: Scope Measurement curve RMS values

With this it is possible to get very easy the RMS current of a drive over a running circuit.
If the cursors are no longer in the picture due to zooming, they can be brought back into
the picture with the context menu "right mouse button"→ "Centre cursors".

Fig. 360: Scope Measurement curve Centre cursors

The displayed length of the parameter name in the cursor list can be chosen in the con-
text menu.



19 | Scope KEB Automation KG

270 ma_mu_sw-cv68-20428970_en

Fig. 361: Scope Measurement curve Parameter name

19.12 Save recordings
Several scope recordings can be added to the project and saved with it.
Each scope can save one recording.

Fig. 362: Save scope recording

(≡► Add a New Scope [} 239])

see also
2 Add scope to the project [} 239]
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2 Add a New Scope [} 239]

19.13 Import / Export
With the export and import function Scope records can be stored outside of the project or
external files can be imported. The file extension is “sc6”.

1

2

3
4

Fig. 363: Scope recording

1 Clears the display. 2 Copies the displayed picture to the
clipboard. Can be used e.g., in MS-
Office programs.

3 Imports a COMBIVIS 6 scope file,
the actual displayed curves will be
erased.

4 Exports the actual scope curves in a
SC6 or a CSV-format e.g.,for saving.

19.14 Export to CSV format
Exports the current scope curves in a CSV-format.This allows importing the recorded
curves in e.g., Excel program.



19 | Scope KEB Automation KG

272 ma_mu_sw-cv68-20428970_en

Fig. 364: Export scope files

Fig. 365: Scope Export to CSV format

Adjustments of “CSV”-format by: "Tools” → “Options” → “KEB-Scope” → “Extended“
Files in csv format cannot be re-imported.

19.15 Trigger function (online)

19.15.1 Trigger function in online mode
This function realizes in case of long-term recordings a limitation of the saved period (e.
g. period around a defined error occurrence). Therefor a trigger event will be defined
(e.g., a special drive controller status or a reached current level).
Around this event a predefined time domain will be saved. That results in a compact
scope-file also for long term recordings.
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This function will be adjusted and activated in the window “Scope” → “Settings".The trig-
ger event will be placed in scope display at 0 ms on the time axis.

1

2

3

4

5

6

Fig. 366: Scope trigger function

1 Trigger channel: On which channel
shall be triggered?

2 Which trigger pulse edge or level?

3 Lead time: saved time before trigger
event.

4 Over travel time: saved time after
trigger event.

5 Level, absolute relating to unit or
percentile relating to range of values.

6 Activate trigger function.

Example:
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Fig. 367: Scope trigger function Exmple

19.16 Offline mode
The Offline mode uses the function of the fast Scope mode’s 4 channels to buffer para-
meter values in the device. Therefor a part of the device’s storage is reserved.
Via channel allocation recording and filling of storage will be generated. The storage
works like a drum store. each new value overwrites the oldest one.
The store will be frozen by a trigger event and can be read-out by scope. Because of a
faster data communication in the devices than to the PC it can be recorded with a shorter
time grid.
Useful for:
• Shorter time grid, therewith better hit rate in short peaks
• Recording without PC
• Recording of sporadically events.
Characteristics:
• Available for COMBIVERT F5 but not F5-Basic, B6, F6, G6, H6, S6 and P6 drive con-

trollers
• Contrary to online mode data won‘t be readout sequential from the drive controller and

displayed but internally saved in the drive controller.
• No dependency on communication time, therefore very short frames realisable.
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• Up to 4 channels in one device will be recorded with chronological synchronism and in
a fixed frame (fast Scope mode).

• For data recording a connection drive controller to PC must not be active.
• Flexible trigger conditions allow a selective recording of sequences.
• Trigger will be released by a digital input.
Also, after drive controller‘s power-off the trigger requirement will remain unaffected (only
F5-A/M, S, H, K, L, P, E ≥ D housing). In COMBIVERT G6 the trigger condition will be
saved after Power Off, stored date will be lost. It is possible to trigger intermittent effects
over a long period. At COMBIVERT F6/ H6/ S6/T6, the values and the triggers are lost
when the supply is switched off.
• At COMBIVERT F5, B6 and G6 all Parameters are recorded only from set 0.

19.16.1 Switch on and adjustment of time basis

Activating of Offline mode: “Scope” → “Settings” → “Mode”

1

Fig. 368: Set scope time base

1 Reading out a stored recording. The
channel assignment is read out auto-
matically.

Set the time base (sampling rate):
Maximum number of buffered values * scan time = stored time. That means: the smaller
time base the shorter recorded time.
Max. quantity of values depends on controller‘s data space ((≡► Storage Capacity
[} 279])).

Fori COMBIVERT H6/F6/S6/P6/T6 the sampling rate depends on the set-
ting in parameter is22 / time base Tp. Only multiples of the time base set in
is22 can be used (rounded if necessary).
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Fig. 369: Scope time base switching frequency

19.16.2 Adjusting of trigger source
Digital o softwae inputs act as trigger source.
The activation of inputs initiates a saving of the scope recording. e.g.: setting “F” for re-
cording of acceleration. If no trigger source is set, the drum store is filled and read out
when recording starts.

Fig. 370: Scope Setting the trigger source

With the software inputs IA ... ID, complex trigger conditions can be realised indirectly via
the software outputs OA ... OD e.g.: Switching condition "apparent current>level" via out-
put OA to input IA.
Example for COMBIVERT F5 (similar for G6):
A description and 2 samples can be found by menu “Help” → “Show FAQ” Documents”
→ “FAQ CV6 0003 OfflinescopeTriggerConditions (en)”. Also 2 sample parameter lists
are included.
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Fig. 371: Scope KEB Documents

Fig. 372: Scope FAQ

19.16.3 Adjusting of trigger position
Trigger position defines how many percent of the complete recording period before trig-
ger event shall be displayed.
Example: 30% = 30% of recording indicate the period before the trigger event.
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Fig. 373: Scope Setting the trigger source

Remark:
When the recording is started, the offline memory (ring memory / drum storage) is filled
with values. Until the memory has finished the first loop values from previous records can
be in. If, after the start of the recording, the trigger still comes within the first “round” and
has only a little delay, it may be that the previous values have not yet been overwritten
and are displayed.

19.16.4 Application

Start offline recording via click on start/stop button  or tap key “F9”.
In the bottom of the scope-window the flashing code “wait for trigger” appears. The drive
controller waits for the trigger event.
The code will change into “data recording” as soon as the trigger event occurs. The re-
cording will be realised and saved.
If the saving process is finished, the code will change into “offline data readout”. The
saved data will be red out by scope and displayed.
After reading out the diagram can be handled like in online-mode.

Recording without connected PC and read out afterwards
Start offline recording by start/stop button or tap key “F9” → at the bottom of the display is
shown blinking “Wait for trigger”→ the device is waiting for the trigger condition.
Close COMBIVIS 6 without stopping the scope, if applicable save project. Disconnect the
PC from the device.
When the first trigger condition occurs, the curves will be saved in the device´s storage.
Further will be ignored.
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Connect cables as shown before → start COMBIVIS 6 with the respective or with a new
project → if needed get connection to the device → at “Scope” → ”Settings”:

 → the saved data will be read out of the device and dis-
played in Scope.
The saved data will be erased at F5-A/-S/-E/-H; ≥D-housing only by a new starting of off-
line recording. The drive controller can also be switched of in the meantime. At G6/ H6/
F5-A-Servo (A housing) trigger requirements and saved data will be erased also by
switching off the device or by overwriting.
For example:
Time base: 500µs - trigger source: F - trigger position: 5%

Fig. 374: Scope Trigger function Example1

19.16.5 Storage Capacity
e.g.: in KEB COMBIVERT F5-A Version 4.2: ≥ D housing
For 1x or 2x 16 bit parameters: approx. 1900 values/channel
For 3x or 4x 16 bit parameters: approx. 950 values/channel
For 1x or 2x 16 and 1x or 2x 32 bit parmeters: approx. 470 values/channel

(32-bit-parameters are e.g., position, torque, and control / status word long)
Therewith 4 channels with 16 bit in 0.5ms time basis give approx. 0.47s recording time.
For the other drive controllers this might differ strongly.
For example: a KEB COMBIVERT G6-G has approximately 20% more space.
COMBIVERT F5-C has approx. 70% less and COMBIVERT B6 approx. 86% less.
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20 Search function
There are two different search functions in COMBIVIS 6:

20.1 General text search
The general text search under the "binoculars" in the toolbar (only with COMBIVIS studio
6):

Fig. 375: Search function binoculars

Here is just looking for texts in specific fields.

20.2 Parameter search
The parameter search is opened with Ctrl + Shift + F or the icon in the toolbar. Paramet-
ers can be searched in the Device Editor and parameter lists in the project.

Fig. 376: Search function Parameter search dialogue
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1

2

3

4
5

6

Fig. 377: Search function Parameter list

1 Search text 2 Jump to next result
3 Shows all results in Search Results

window
4 Setting text type

5 Search area 6 Search specifications

Normally, the parameter search is done from the current cursor position to the end. If the
parameter you are looking for is in front of it, it will not be found. With the "end from the
beginning" option the parameter will be found, but it may be in a loop and the user must
decide at which point the loop is executed.

Searches can be made for:
• Parameter ID (abbreviation). Search field must be set to “IdTxt”. (Parameter Id without

dot).
• By parameter name: e.g., “current” all-the parameters will be found with the term “cur-

rent” in the name.
• By hexadecimal address: Default as 1234h or 0x1234 possible.
• By entries in the "Comment" column (only in parameter lists)

Fig. 378: Parameter search - search field
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20.2.1 Search methods:
If you click on "Continue search", the display window jumps to the next location.

Fig. 379: Search function parameter search continue search

With "Search all" a new result window opens in the message window with all the loca-
tions. Clicking the lo-cality in the results executes a jump to the appropriate place in the
editor or in the parameter list.
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Fig. 380: Search function Search methods
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21 Document database
All KEB documents can be viewed via the COMBIVIS internal document database. The
programming manuals of COMBIVERT F5, G6 and F6/S6/H6 are integrated in the basic
configuration. Other documents, such as manuals, catalogues and E-Plan data can be
downloaded as data packages via the Internet.
Using the document database requires registration of COMBIVIS 6 or licensing of
COMBIVIS studio 6. A registration request is available at the bottom of the home page or
under menu bar: "Help" → "Registration". The registration is free of charge.

21.1 Add/remove documents
The documents are grouped in packages. Documents are updated via the auto-update
function. An Internet connection to the KEB homepage (► www.keb.de) is required for
the installation or update.

The database administration is opened via the start page item "Manage KEB Docu-
ments".

Fig. 381: Document database Manage Documents

or via the toolbar:

http://www.keb.de/
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Fig. 382: Documents database Add documents

The administration window opens:
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1
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3

4

Fig. 383: Document database overview of available installed packages

1 Overview of available / already in-
stalled packages.

2 Marked packages will be installed.

3 Info about the content of the pack-
age.

4 Data volume of the selection.

The document packages available on the computer are displayed in the "Installed" tab. A
green background means that the package is up to date.
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Fig. 384: Documents database Documents installed

21.2 Use document database
There are two ways of accessing the documents:
Global access to all available documents:
The database is opened via the start page "KEB Documents".

Fig. 385: Documents database Documents

or via the toolbar:
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Fig. 386: Documents database Show documents

The editor "KEB documents" opens:

It is possible to search by part number, file type, area and/or language.

1

2

3

Fig. 387: Document database Search mask

1 Editor 2 Search mask
3 Result of the filtering

When entering the part number, devices are suggested which are contained in the config-
uration database. Part numbers of other KEB devices are also accepted.
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Fig. 388: Document database Selection

The document is opened by double-clicking on the document name. Various options are
available via the context menu - right mouse button - on the document name.
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Fig. 389: Document database Installation S6 housing 2

Device-dependent access to the documents:
In the device editor there is a tab "Documents".Here, the documents can be filtered by
device part number. One or more entered part numbers are permanently assigned to the
device in the project.

1

2
3

4

5

Fig. 390: Document database Filter

1 Freely selectable name 2 Add / remove device to the list
3 Part number of the device 4 Update
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5 Documents available for selection.
Open by double-clicking with the
mouse.

Apply from configuration
For a project created with the configurator, the associated documents can be transferred
automatically (KEB Configurator).

1

Fig. 391: Document database Apply Configuration

1 Load data from configuration.

21.3 KEB PDF viewer
The KEB PDF viewer is a simple program adapted to the KEB document database. It is
installed with the installation of CV6.
Other viewers can also be used, but some of them have limited functions, such as Adobe
Reader. The search for parameter information of the parameter cannot be carried out
there if the document is already open.

1

2

3
4

5

Fig. 392: Document database PDF viewer

1 Tool list 2 Search window
3 Search result 4 View of the document
5 Content

The toolbar can be adjusted by grabbing and moving the fields on the dashed line with
the mouse.
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Fig. 393: Document database Adjust toolbar

The used PDF viewer can be set under toolbar "Tools" → "Options" → "KEB Docu-
ments".

Fig. 394: Document database Options
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Fig. 395: Document database PDF settings
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22 KEB Safety Module Editor
The KEB safety module editor is used for parameterisation and analysis of data in
the KEB safety modules in COMBIVERT F6, H6 and S6.
Special system requirements apply for the safety module editor.
System requirements

22.1 Safety Parameter Editor

22.1.1 Safety instructions
This chapter contains general safety information about the Safety Parameter Ed-
itor.
Further safety information on specific usage situations of the Safety Parameter Ed-
itor can be found in the corresponding chapters.

22.1.1.1 Basic Safety Instructions
This chapter contains general safety information for using the Safety Parameter
Editor.
Further safety information on specific usage situations of the Safety Parameter Ed-
itor can be found in the corresponding chapters.
Further safety information on the configured devices can be found in the corres-
ponding instruction manuals of the devices.

 WARNING Incorrect assembly or use.
The intended safety level may not be achieved if the device is not installed or
used properly.

a) All valid standards, guidelines and manuals of the manufacturer must be ob-
served during assembly, installation and use!

b) National and international legal regulations must be observed for the installa-
tion and use of the safety device as well as for the start-up and periodic tech-
nical inspections.

c) Manufacturers and operators of the machine or system where a safety device
is used must coordinate and comply with all applicable safety regulations/rules
on their own responsibility with the authority responsible for them.

d) The instructions, in particular the test instructions in this instruction manual
(e.g. for use, assembly, installation or integration into the machine control sys-
tem), must be observed.

 WARNING Ineffectiveness of the protective device.
If not observed, the dangerous condition may not be ended or may not be
ended in time.
ü The safety device parameterised with the Safety Parameter Editor can be used

as part of a protective device.
a) Read the document carefully and ensure that the contents are fully understood

before operating the device!
b) Observe all safety instructions in this document.
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22.1.2 Product description
This user manual describes the Safety Parameter Editor and how to use it to para-
meterise safety devices.

22.1.2.1 Intended use
The Safety Parameter Editor is used exclusively for configuring and parameterising
safety-related KEB devices.

22.1.2.2 Non-intended use
Multiple execution of the Safety Parameter Editor is not permitted (≡► Multiple ex-
ecution of the Safety Parameter Editor [} 297]).

22.1.2.3 Conditions
Hardware
• PC / Laptop
• Screen resolution at least 1000 x 700 pixels
• Keyboard / mouse

Software
• Windows from version 10

22.1.2.4 Further information

You can find more information at (► www.keb-automation.com).

NOTICE Parameter and device properties depend on the individual device configura-
tion.

a) Use the instruction manual provided for this purpose.

22.1.2.5 Installation
The Safety Parameter Editor is installed by its software environment. Please note
the instructions for installing COMBIVIS .

22.1.3 Operation

22.1.3.1 Standard view of the Safety Parameter Editor
After starting the Safety Parameter Editor, you will see the following view:
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Fig. 396: Standard view

22.1.3.1.1 Parameter table
The parameter table is in the centre, where you can see the following columns for
each parameter group and each parameter:

Name Meaning
ID Unique number for each group and each parameter of the group.

The counting number of the group is before the dot,
A parameter has the ID of the group before the dot and a counting
number for the parameter after the dot, starting with one. These
numbers are permanently assigned to the groups and parameters.

Name Name of the group or parameter. Names are defined by KEB and
depend on the language. Names cannot be changed.

Value Parameter value. You can enter a value suitable for the application.
Unit Some parameters have units, these cannot be changed.
Comment You can give each group and each parameter a comment with a

maximum of one thousand characters.
Tab. 1: Parameter table

22.1.3.1.2 Head area
You will find the following fields in the head area:

Name Meaning
Safety module type Type designation of the safety module. You can select

this outside the Safety Parameter Editor.
Description Brief note on the selected type
CRC Checksum of the current device parameterisation

(parameter set). It is used for comparison if you have a
safety device with a parameter set. If the CRCs are the
same, the parameter set is identical

Configuration comment Display for the comment you can give to the entire con-
figuration. Double-click on the field to open the input.

Tab. 2: Displays in the head area
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22.1.3.1.3 Documentation
On the right side you will find documentation for the currently selected parameter.
At any time, exactly one parameter or parameter group of the parameter table is
selected. You will also find documentation on the parameter group and the para-
meter itself on the right.
At the bottom of the help window, there are three values for the current parameter:
the minimum value, the default setting (default value) and the maximum value. The
display is always abbreviated in the form:
"MIN <= DEFAULT <= MAX“

22.1.3.1.4 Foot area of the Safety Parameter Editor
In the foot area of the Safety Parameter Editor there are further displays and func-
tions that can be selected with the mouse via tabs. More on this below.

22.1.3.2 Multiple execution of the Safety Parameter Editor
The Safety Parameter Editor is integrated into its software environment and can
only be started once. Multiple execution of COMBIVIS (if this is possible) can then
lead to simultaneous operation of the Safety Parameter Editor. This parallel opera-
tion is not intended and is not permitted.

22.1.3.3 Navigating in the parameter table
You can use the keyboard and mouse to navigate in the parameter table of the
Safety Parameter Editor. The Safety Parameter Editor supports the following keys:

<Pfeiltasten> moves the cursor in the corresponding direction
<Pos 1> jumps to the beginning of the table
<Ende> jumps to the end of the table
<Page up> scrolls to the previous parameter group
<Page down> scrolls to the next parameter group
<Tab> jumps to the next field
<Umsch>+<Tab> jumps to the previous field

22.1.3.4 Automatic setting of column widths
The Safety Parameter Editor automatically sets the minimum column width of the
parameter table for the following columns:
• Name
• Value
• Unit
The width is chosen so that all existing texts in this column fit into it. However, com-
ment texts may be longer.
You can use the grid dividers in the column headings to set the column widths with
the mouse. However, the Safety Parameter Editor does not save these settings.

22.1.3.5 Tooltips
If a text in the table does not fit into the field, it will be cut off; you can see this by
dots on the right edge instead of the text. In this case, you can scroll the mouse
over the text and a tooltip will appear that displays the complete text.
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22.1.3.6 Input of safe parameter values
All parameters already have a valid value after starting the Safety Parameter Ed-
itor. You can adjust this value according to the requirements of the safety applica-
tion. To do this, navigate in the parameter table to the parameter to be changed,
within the parameter line to the "Value" column.

22.1.3.6.1 Open the edit mode
To change the parameter values, switch to edit mode using the keyboard or
mouse:

- Keyboard: <Enter> or <F2> (<F2> for compatibility with Excel)
- Mouse: Double-click on the cell with the value (i.e. in the "Value" column)

The input or selection field in edit mode has a yellow background. At the same
time, a control field opens at the top right, also in yellow. In the control field, you
see the input value of the parameter in its original format. For more information,
see chapter (≡► 4.6.5 [} 299]).

22.1.3.6.2 Parameter values
The Safety Parameter Editor displays parameter values according to the data type
of the parameter in a precisely defined format.

Data type Rules Example(s)
URANGE "0“...“255“ (8-Bit)

"0“...“65535“ (16-Bit)
"0“…“ 4294967295“ (32-Bit)

"231“
"10000“
"30000000“

SRANGE "-128“ … "127“ (8-Bit)
"-32678“ … "32767“ (16-Bit)
"-2147483648“ … "2147483647“ (32-Bit)

"-10“
"1000“
"-100000“

ENUM Depending on the specifications for the respective
parameter

"ON“
"OFF“

FLOAT • No exponential notation
• Always displayed with 6 decimal places
• Language-dependent display (decimal point "." in

English, decimal point "," in German).

"-120000,000000“ (DE)
"-120000.000000“ (EN)
"0.001234“ (EN)

Display of parameter values
Special feature of FLOAT parameters: the resolution accuracy of the used 32-bit
floating point format is 24 bits, which corresponds to about 7 decimal places. This
has the following effects:
1. Very small values close to 0 are not displayed with their actual precision. There

are many valid values between "0.000123" and "0.000124", which you can
even enter, but which cannot be differentiated in the display.

2. Very large values are displayed with a supposedly high degree of precision.
However, the numbers 100000 and 100000.007813 only differ by 1 bit. If you
enter 100000.005, 100000.007813 is saved and also displayed.
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22.1.3.6.3 Input of numerical values
Parameters of the data types URANGE, SRANGE or FLOAT (see user manual of
the safety device) have an input field (editor) for entering values, in which you enter
the numerical value using the keyboard. You can use the usual keys for input and
correction and navigate in the field with keys or the mouse.

22.1.3.6.4 Selection of enum parameters
You can select parameters of the ENUM data type (enumeration data type) from a
list. In edit mode, the selection field (control element) opens, which can be used
with the mouse or keyboard. Select a value from a list of valid parameter values.

22.1.3.6.5 Input and control display
After each change, the Safety Parameter Editor reads out the entered numerical
value or the selected value, checks it and displays the result in the control display.
To do this, the Safety Parameter Editor checks after each character input whether
the currently visible text is a valid value for this parameter.
If you have entered a valid value, the Safety Parameter Editor displays this in the
control display as a numerical value, as SaMoCon evaluates your input.

Fig. 397: Figure: Input and control display

If you make an invalid input (either by entering an incorrect character string or a
value that violates the permissible limits of the parameter value), the Safety Para-
meter Editor indicates this in the control display ("Invalid Entry"), with a message
directly next to the input field.
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Fig. 398: Figure: Control display "Invalid Entry"

It is permissible and quite normal for the Safety Parameter Editor to recognise in-
valid value entries (e.g. only a minus sign without a numerical value) as invalid and
to display them as invalid in the control field. You do not have to react to this.
The control display displays the parameter values as the Safety Parameter Editor
will save them in the device configuration. For parameters of the data type FLOAT,
the resolution is limited and deviations within the scope of the resolution are pos-
sible and permissible as a matter of principle.

22.1.3.6.6 Check and finalise your input

 DANGER Incorrect values in safety parameters can lead to dangerous situations.
a) After entering a new parameter value, check in the input field and in the control

field whether the Safety Parameter Editor has correctly interpreted the value
you have entered.

b) By completing the input, you confirm that you have carried out the check.

Finish the input with the <Enter> button and the Safety Parameter Editor will trans-
fer the entered value into the device configuration. The Safety Parameter Editor im-
mediately calculates a new checksum for this changed device configuration and
displays it.
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 WARNING Unsuitable parameter values in safety applications.
a) Check new parameter values in a suitable way to ensure that expectations are

met in the safety application.
b) Prove effectiveness through suitable tests.
c) Document the results.

Invalid values (inadmissible characters, limit exceedings) are not <Enter> accep-
ted. This message appears instead:

Fig. 399: Message for incorrect inputs

You can then continue with "Yes" and correct the input.
If the value has been successfully transferred into the parameterisation, you will
not receive any further message.

22.1.3.6.7 Options for leaving the input
There are other ways to leave the input. The Safety Parameter Editor will only ac-
cept your input into the device configuration if you have expressly agreed to this.

The variants are:

22.1.3.6.7.1 Cancel with <Escape>
You cancel the input with <Escape>. The original parameter value before the input
is retained and is also displayed again.

22.1.3.6.7.2 Mouse click on another element
You close the input field by clicking the mouse on another field in the parameter
table or on another control/display element of the Safety Parameter Editor. In this
case, the Safety Parameter Editor opens an inquiry (message box). Example:
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Fig. 400: Inquiry: "Accept the changes?"

You have three possibilities indicated in the display for reaction.
• "Yes" corresponds to the behaviour when the input is completed with <Enter>

(Chapt. (≡► 4.6.6 [} 300])).
• "No" corresponds to the behaviour when canceling with <Escape>(Chapt. (≡►

4.6.7.1 [} 301])).
• "Cancel" leaves you in the input mode, so you can continue where you left off.
Please refer to the notes in chapter (≡► 4.6.6 [} 300]) to check your input and for
the following steps.

22.1.3.6.7.3 Mouse click on another element at invalid input
If you leave the input field by clicking with the mouse on another field of the para-
meter table or another control/display element of the Safety Parameter Editor while
the previous input field has an invalid value and the control display indicates this,
the Safety Parameter Editor opens an inquiry (message box). Example:

Fig. 401: Figure inquiry "Continue input?"

You have two options for responding to the display:
"Yes" remains in the input mode, you can continue where you left off.
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"No" corresponds to the behaviour when canceling with <Escape>(Chapt. (≡►
4.6.7.1 [} 301])).

22.1.3.6.7.4 Other variants
If the Safety Parameter Editor is closed externally, for example, the Safety Para-
meter Editor cancels the input automatically. The Safety Parameter Editor does not
accept the entered value.

22.1.4 Functionality
22.1.4.1 Import data from old tools

Older versions of COMBIVIS were able to parameterise the safety modules with
the integrated tool SAFEGRID. The entered data were saved in the COMBIVIS
project or as export files (with the file extension "*.spd"). You can transfer these
parameters to the current COMBIVIS version and also to the safety parameterisa-
tion.

 DANGER Import from old tools and projects
Incorrectly adopted parameter values can cause serious damage.
ü If you transfer safety parameters from older projects that were created with the

SAFEGRID tool.
a) Check correctness of parameter values.
b) Document the transfer

For the test, you can use a previously created report for comparison, for example.

22.1.4.2 Import of device configurations from older versions
In the Safety Parameter Editor, you can only edit parameter data sets (configura-
tion data) that match the preset device configuration. The import functions check
this and reject configuration data that does not match.
However, the integrated update function allows you to import configurations of cer-
tain older versions. Which these are depends on the currently set version. Informa-
tion on these dependencies can be obtained from KEB.
If you have set a current version and import the configuration of an older version.
The Safety Parameter Editor automatically recognises whether the older version is
compatible with the current version. If so, the Safety Parameter Editor asks
whether you want to import the configuration of older versions.

Fig. 402: Compatible version

The Safety Parameter Editor imports this configuration with <Ja>. The configura-
tion will automatically receive the new, active version.
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The new version may have parameters that were not included in the older configur-
ation. If this is the case, then these new parameters receive their default value. The
following message is displayed:

Fig. 403: Note, new parameters

To help you, all the new parameters are displayed in a list in the message area of
the Safety Parameter Editor:

Fig. 404: List of new parameters

You can jump directly to the entry in the parameter table by clicking on a list ele-
ment.
Clicking on the trash icon will hide the entire update display.

22.1.4.3 Documentation function
The Safety Parameter Editor offers a documentation function that you can use to
document the device configuration you have created. In the following, the docu-
mentation function is referred to as a report.

NOTICE Observe the obligation to document device configurations.
a) Users are obliged to document device configurations that they have manually

adapted and that are used in safe SGS devices in a safety related environ-
ment.

NOTICE Clear personalisation of the documentation
ü The Safety Parameter Editor allows names with a length of 2 to 48 characters.
a) Enter your name to generate the report.
b) The name should enable a clear assignment to the person.
c) If unclear, the company name or department should be added. This means you

meet the requirements of the standards (IEC 62061, ISO 13849-1).

Proceed as follows:
Select the report function to enter the report dialog.
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Fig. 405: Report dialog (with example data)

You can enter or change your name and the configuration comment in the report
dialog. You can select the following actions (click on the buttons):
1. <Abbruch> cancels the dialog. Changes are not adopted.
2. <Save/close> closes the dialog. Inputs are accepted.
3. <Report Preview> opens the preview. The preview shows you how the output

will be printed in the report. You can start printing from the preview by clicking
on the buttons or return to the report dialog.

4. Print opens the print menu. You can select the printer, including the PDF
printer installed on your system (depending on the Windows installation).After
the printing process is completed, the Safety Parameter Editor closes the re-
port dialog.

While the report dialog is active,
• you cannot perform any further actions in the Safety Parameter Editor
• the other controls are disabled.
You must first leave the report dialog in order to continue using the Safety Para-
meter Editor.

22.1.4.3.1 Report content
The report contains the following sample outputs (extract from the preview):
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Fig. 406: Extract report preview

22.1.4.4 Error display/message display
The Safety Parameter Editor usually displays errors and messages in a message
box and also in the error and message display in the lower area of the Safety Para-
meter Editor.
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Fig. 407: Message display

The message and error displays include a history of messages since the start of
the Safety Parameter Editor.
Messages (such as errors) are always displayed as follows:
• Class (INFO, WARNING, ERROR, FATAL)
• Time stamp
• Message or error text
• Supplement (optional, e.g. version number)
You can delete the list of error/messages by clicking on the trash can. If there is a
serious error, it cannot be deleted from the display.
The tab above the messages indicates in colour if there are errors or messages in
the list.Even when the list is hidden (e.g. because you are entering text in the com-
ment editor), it is visible if there is a message or error.
Markings
Blue => Messages
Yellow => Simple errors
Red => Serious errors
Errors have a higher priority than the other outputs. If an error occurs, the error dis-
play automatically changes in the foreground. You can then switch to another tab
by clicking on it.

22.1.4.5 Search function
The Safety Parameter Editor offers a search function. This allows you to enter a
search text and find the places where the text appears.

Fig. 408: Search function

Proceed as follows:
By clicking on “Find” you will get to the Find dialog.Click on the search text input
field and enter your search text there. Press Enter (or click on the magnifying glass
icon) to start the search.
The Safety Parameter Editor displays the result in list form. On the left you see the
ID numbers of the parameters that contain the search text and on the right the text
passage with the found search text (marked in colour). By clicking on an entry in
the list you navigate to the parameter with the ID number at the top.
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The search includes all parameters of the current display, i.e. all the groups you
have selected. If the text is not found, you should select all parameter groups and
repeat the search.
The search includes all columns of the parameter table, the help on the right and
the comment on the entire configuration.
If the search text is found multiple times, you will receive a corresponding number
of entries in the results list, possibly also for a parameter.
If the search text is further back in a longer text, the Safety Parameter Editor
moves the display in the table so that you can see the search text. To do this, the
Safety Parameter Editor cuts off characters on the left and marks this with "…“.

22.1.4.6 Undo/Redo function
This function can be used to Undo one or more parameter value entries. If an input
is undone by this function, it can be restored using the Redo function.
Both the Undo and Redo functions have a memory in which they store previous
entries. For the Undo, every input of a parameter value by the user is recorded and
stored. When Undo is executed, the Safety Parameter Editor undoes the last input
and stores this action (i.e. the Undo) in the Redo memory so Redo can undo the
Undo function. When executing Redo, the Safety Parameter Editor proceeds in the
opposite way.
By alternating between Undo and Redo, you can undo and redo an input as often
as you like.

With the following user actions, the Safety Parameter Editor deletes both memor-
ies:
1. Closing the Safety Parameter Editor
2. Importing a configuration
3. Resetting the configuration to default values
4. Selecting groups for display

This means that after these user actions, no further Undo is possible for inputs
made before the respective user action. This also applies to Redo.

22.1.4.7 Extended plausibility check
With the extended plausibility check, the Safety Parameter Editor provides a further
check of parameter data. While the standard check verifies the value limits during
input and does not allow any unauthorised values in the entire parameterisation,
the advanced check goes one step further.
The extended check performs exactly the same checks that are carried out in the
security device at startup. There may be dependencies between parameters.
Example:
A minimum value of parameter yy must not be higher than the value of parameter
xx.
(Parameter yy limits the permissible value range of parameter xx).

The actual rules depend on the security device and are documented in the manual
of the respective device.
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The check is always carried out:
1. when importing a device configuration
2. After entering a valid new parameter value

If one (or more) errors are detected, a message is displayed in the foot area of the
Safety Parameter Editor:

Fig. 409: Display plausibility errors

The display allows you to solve the problems before you receive an error message
from the security device.
If you have adjusted the parameters, the message will disappear as soon as the
parameters are "plausible".

The display of messages from the extended plausibility check has no
direct influence on the functions of the Safety Parameter Editor. You
can save, export and reimport a configuration, even if there is a mes-
sage.

You do not have to respond to a message immediately. If you want to
change two parameter values and an implausible combination occurs
in the meantime, then continue as planned.
Before downloading the parameterisation to the safety device, the
parameter set should be plausible, otherwise you will receive the cor-
responding error message from the device.
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23 Update

23.1 Manual check for new version
A connection to the KEB homepage is established with the "Check for updates" function
on the start page or in the "Help" menu, provided there is a connection to the Internet.
The file versions and documents are checked for a new date and downloaded and integ-
rated on request.

Fig. 410: Update Help Check for updates

Fig. 411: Update All components are up to date

23.2 Automatic check for newer version
An automatic check for newer versions is set as background function when connected to
the Internet.
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(≡► Options - Online update [} 138])

23.3 Manual update of the parameter description file
If an Internet connection to the KEB homepage is not possible, the parameter description
file can also be updated with an external memory (e.g. USB stick).

Search for the file "paras.xml" at (► www.keb-automation.com) → save on PC or stick
→ integrate via menu → "Tools" → "Import KEB parameter description file".

Fig. 412: Updating tools

After the import, the file must be reloaded or COMBIVIS must be restarted.

http://www.keb.de/
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24 Device storage

24.1 Device storage wizard
The device storage wizard enables the transfer of recipe lists into the device memory of
COMBIVERT F6 and S6 as of firmware V2.3.
The connection can be made via:
• Cable part. no. 0058025-001D
• KEB-USB serial converter part. no. 0058060-0040 from version V2.4 and the designa-

tion "FTP ready" on the name plate
• UDP Port 8002 on COMBIVERT F6/S6 Pro on the internal Ethernet interface
Note:
• The F6 Ethernet or USB operator opens only access to the operator-internal store, not

to drive controller!
• Files in compressed form (zip files) cannot be loaded into the device storage.
• Accessing the device storage and loading recipes into the device only works when the

modulation is switched off (status voltage enabled, switched on, ready to switch on).
The function of the recipe management is described in the manual of the COMBIVERT
(keyword: recipe management). It can be found in the (≡► Document Database [} 284])
With the device storage wizard also other file types can be transferred (description files,
firmware, etc.).
The drive storage wizard is in the device editor:

Fig. 413: Drive storage



Device storage | 24

ma_mu_sw-cv68-20428970_en 313

1 2 3 4 5 6 7

Fig. 414: Device storage connections

1 Connection blue = communication
with device storage, green = with
device, red = offline

2 Establish connection with device
storage.

3 Display file system 4 Files on the PC
5 Transfer file 6 Files in the device storage
7 Storage area for file transfer

Recipes have the file extension "dw5".

24.1.1 Access level / password
Depending on the file function, a specific access level must be entered for transfer:
• User access: Level 3 = Application, password: 440
• Service access: Level 5 or 6 = Supervisor, password ***

User-specific passwords are not possible.
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Fig. 415: Device storage application

The password must be set via the key symbol.

Fig. 416: Device storage Password

The key symbols in the toolbar or below in the parameter editor do not work here! The
current access level is displayed here:

Fig. 417: Device storage current access level

After Power-On-Reset the access level is 0: read-only.
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24.1.2 Connection setup
Klick on the button "Connect".If needed enter the device password.
The connection to the parameter interface (green contactor in the navigator) is interrupted
and `redirected` to the internal storage (blue contactor). The parameters are not access-
ible while using the device storage wizard.

Fig. 418: Device storage connection_setup

Fig. 419: Disconnect device storage

24.1.3 Show stored recipes
Tab Recipe management.
The recipes can be transferred to the Navigator as a parameter list.
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Fig. 420: Device storage Recipe management

24.1.4 Create a recipe
A parameter list can be loaded directly from the Navigator as a recipe into the
COMBIVERT. Select the parameter list → right mouse key → "Download as recipe“.
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Fig. 421: Drive storage download as a recipe

A password is required. The user password is typically "440" (Level 3).
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Fig. 422: Enter drive storage password

The file names of the recipes must meet certain criteria (=> Programming Manual). The
function and the name can be selected.

Fig. 423: Drive storage Next free ID

With "OK" the list is transferred as a recipe to the drive storage. Doppelte Dateinamen
werden dabei vermieden.
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Fig. 424: Drive storage Parameter list_test

24.1.5 File system / transfer file
In the "File system" tab, the file system of the PC is shown in the left half of the window
and the COMBIVERT file system is shown in the right half of the window.
The drives C: and D: are available in COMBIVERT. Normally, C: stores the user-specific
files (recipes) and D: the system-relevant files (firmware, etc.).

The file names of the recipes must meet certain criteria (=> Programming Manual).

Transfer a recipe from the PC file system to the COMBIVERT: Select (mark) files →
by > transfer from one to other file system
or drag and drop the file with the mouse from the PC file system onto the dashed area.

Fig. 425: Transfer device storage parameter list

Transfer a recipe from the PC file system to the COMBIVERT: Select (mark) files →
by > transfer from one to other file system.
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Fig. 426: Execute device storage parameter list

24.1.6 Edit recipe in the file system
The recipe can be deleted from the file system (trashcan icon). The recipe name can be
changed.

Fig. 427: Rename device storage recipe

The content of a recipe can only be changed by transferring it as a parameter list to the
Navigator and saving it again as a recipe after the change.
(≡► Show stored recipes [} 315])

24.1.7 Disconnect connection
After the connection has been disconnected, the connection to the parameterisation inter-
face of the COMBIVERT opens again = green connector symbol in the Navigator. Due to
blocking times, the switching time is approx. 10 seconds.
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Fig. 428: Disconnect device storage

24.2 KEB FTP File Transfer Program
The KEB File Transfer Programme (KEB FTP) can be used to exchange data between
KEB components. The following transfer is possible:
• PC and KEB Portable Operator (Part number 0058060-1010 /-1110) with USB cable
• PC and COMBICONTROL C5 / C6 COMPACT I+II, H6CU, P6, T6MCU with LAN cable

(not with KEB USB converter).
• PC and the operating operator of the COMBIVERT F6 with USB or LAN cable (UDP

port 8002).
• PC and COMBIVERT S6/ F6 with cable ((≡► DIN 66019 - RS-232 cable operator

0058025-001D [} 29])) or KEB-USB-serial converter from version V2.4 and the desig-
nation "FTP ready" on the type plate ((≡► KEB USB serial converter 0058060-0040
[} 29])).

• PC and UDP Port 8002 on COMBIVERT F6/S6 Pro on the internal Ethernet interface.

Restrictions
• The 00F6P00-2000 and -3000 operators only open the internal memory of the operator

(not that of the drive controller)! The 00F6P00-4001 operator has two modes for ac-
cessing the operator's internal memory or the device memory.

• Files in compressed form (zip files) cannot be loaded into the device storage.
• Accessing the device storage and loading recipes into the device only works when the

modulation is switched off (status voltage enabled, switched on, ready to switch on).
• Not useable for C6 IPC types!

Opening KEB FTP
Menu bar "Tools“ → "KEB FTP“
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Fig. 429: Device storage Tools KEB FTP

Note:
KEB FTP is a separate program that is displayed in the COMBIVIS 6 window. It can also
be obtained separately from the KEB homepage, independently of COMBIVIS. It is not
possible for KEB FTP and COMBIVIS 6 to serve the same COM-Port at the same time.
So, the used COM Port in KEB FTP must be inactive in COMBIVIS 6 or other programs.
Settings:
IP address or COM Port and password if required (=> device manual) must be set, then
click on button → "Connect".
The password resets, depending on the device, sometime after the last operation. For the
connection to COMBIVERT S6/F6, the baud rate must be set to 115200.
File name length max. (e.g.):
• COMBICONTROL C5 = 8 digits + file extension
• COMBICONTROL C6 = 32 digits + file extension
• Portable Operator = 32 digits + file extension
=> please consider the respective device manual
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1 2 3

4

5

Fig. 430: Device storage Data transfer_PC_device

1 Transfer data from PC to device 2 Communication settings
3 Transfer data from device to PC 4 Data in the KEB device
5 Data in the PC

see also
2 Connection of COMBIVERT F5 [} 37]
2 Connection COMBIVERT B6 [} 38]
2 Device connection [} 37]
2 Device memory (recipe management) [} 127]

24.2.1 Operator 00F6P00-4001
Example: Loading a worklist type .wr5 onto the operator 00F6P00-4001
The operator has 2 interfaces: USB-B and LAN/UDP.
Version 1 with LAN connection via COMBIVIS device editor:
The "Drive memory" in COMBIVIS always accesses the first memory in the data connec-
tion chain. So to the operator memory.
• Connect operator directly to COMBIVERT F6 or via cable 0058025-004A to

COMBIVERT S6
• Connect PC and operator with LAN cable
• Operator not in "FTP local mode" or "FTP bridge mode"
• Establish connection to the device in COMBIVIS (depending on the network, devices,

etc.)
• Open "Drive memory" in the editor
• Establish connection, the plug symbol changes from green to blue
• Insert password "660" (key symbol)
• Transfer file (≡► Device memory (recipe management) [} 127])
• Disconnect connection
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Fig. 431: FTP LAN 1

Version 2 with LAN connection via KEB FTP:
• Connect operator directly to COMBIVERT F6 or via cable 0058025-004A to

COMBIVERT S6
• Connect PC and operator with LAN cable (if necessary, adjust IP address in parameter

fb01 via USB or keyboard)
• Select "FTP local mode" from the operator menu
• In the COMBIVIS Navigator, switch the device "offline" in the context menu (right

mouse button). Alternatively in the "Communication settings" card in the device editor.
• Start Menu / Tools / KEB FTP
• Enter IP address and port Format "xxx.xxx.xxx.xxx.xxx:8002" (enter two-digit number

in two digits only)
• COMs" field empty
• Enter password "660" (user access)
• "Connect"
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Fig. 432: FTP LAN 2

• Access to the PC is visible in the left half and access to the operator memory is visible
in the right half.

• Klick to open the drive C:\ in the operator memory and open
• Select the ready-made work list in the PC
• Transfer with button ">>"

Fig. 433: FTP LAN 3
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• "Disconnect", close FTP, switch device "online"
• Exit "FTP local mode" operator menu
Version 3 with USB cable via KEB FTP:
• Connect operator directly to COMBIVERT F6 or via cable 0058025-004A to

COMBIVERT S6
• Connect PC and operator with USB-B cable
• Select "FTP local mode" from the operator menu
• In the COMBIVIS Navigator, switch the device "offline" in the context menu (right

mouse button). Alternatively in the "Communication settings" card in the device editor.
• Start Menu / Tools / KEB FTP
• Select COM interface
• Enter the baud rate. Format "COMxx:38400" or "COMxx:115200"
• Enter password "660" (user access)
• "Connect"

Fig. 434: FTP USB 1

• Access to the PC is visible in the left half and access to the operator memory is visible
in the right half.

• Klick to open the drive C:\ in the operator memory and open
• Select the ready-made work list in the PC
• Transfer with button ">>"
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Fig. 435: FTP USB 2

• "Disconnect", close FTP, switch device "online"
• Exit "FTP local mode" operator menu

24.2.2 Operator 00F6P00-2000
Connect with operator 00F6P00-2000 (LAN version) via KEB FTP:
• Connect operator directly to COMBIVERT F6 or via cable 0058025-004A to

COMBIVERT S6.
• Connect operator with network cable (if necessary, adjust IP address in parameter

fb01 via USB or keyboard).
• In the operator basic menu (F1 key), move the cursor to "FTP menu", but do not enter

it yet.
• Disconnect the device in the communication settings and set the port to 8002.
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Fig. 436: FTP - Port 8002

• Start Menu / Tools / KEB FTP.
• Enter IP address and port Format "xxx.xxx.xxx.xxx.xxx:8002" (enter two-digit number

in two digits only).
• COMs" field empty.
• Enter password "660" (user access).
• "Connect".
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Fig. 437: FTP - Connect

• Access to the PC is visible in the left half and access to the operator memory is visible
in the right half.

• Klick to open the drive C:\ In the operator memory and open.
• Select the ready-made work list in the PC.
• Transfer with button ">>".
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Fig. 438: FTP Startup

• "Disconnect", close FTP, reset the port in the communication settings, switch the
device "online".

• Exit the "FTP mode" operator menu.

24.2.3 Operator 00F6P00-3000
Connect with operator 00F6P00-3000 (USB version) via KEB FTP
• Connect operator directly to COMBIVERT F6 or via cable 0058025-004A to

COMBIVERT S6.
• Connect PC and operator with USB-B cable.
• In the basic menu of the operator (F1 key), move the cursor to "FTP menu", but do not

enter it yet.
• In the COMBIVIS Navigator, switch the device "offline" in the context menu (right

mouse button). Alternatively in the "Communication settings" card in the device editor.
• In the COMBIVIS menu / Tools / Start KEB FTP.
• Select COM interface.
• Enter the baud rate. Format "COMxx:38400" or "COMxx:115200".
• Enter password "660" (user access).
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Fig. 439: FTP - Connect

• "Connect".
• Press the enter button on the operator within 10 seconds to start FTP mode.
• Access to the PC is visible in the left half and access to the operator memory is visible

in the right half.
• Klick to open the drive C:\ In the operator memory and open
• Select the file in the PC
• Transfer with button ">>"

Fig. 440: FTP file transfer
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• "Disconnect", close FTP, switch device "online"
• Exit "FTP mode" operator menu with F1
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25 IP Scan Tool
The IPScan tool makes it easy to find accessible devices in your own subnetwork.

25.1 Description
KEB IPScan uses the UDP protocol to transfer a block of data to allow detecting KEB
devices with Ethernet. The scan request is sent from a device called “IP Scanner” via
broadcast to reach all devices in the local network subnet range.All devices with IPScan
functionality (KEB Kontiki based firmware) respond to the IP Scanner with their name,
location, and IP parameters. Also, any active instance of IPScan.exe-Software is found
(e.g.: IPScan running in C6-IPC).

25.2 Supported devices
• Full support: embedded devices (C6-C, H6-CU, P6, T6) + Ethernet Operator, Port Ex-

pander
• Limited support: C6 X86 based (ECON, PERFORM, E22, P3X)
• Not supported: arm based WEC7 devices (C6 SMART, C6 HMI LC)

25.3 Ports
The request port is 67 on the UDP protocol, the response port is 68. Sometimes the re-
sponse port on the IP Scanner is in use, so an alternative port can be used (devices with
firmware after year 2014).

25.4 Scan
By pressing the “Scan devices” button a call to the network is issued and the responding
devices appear in the list below.

25.5 Wink
By pressing the “Wink this device” button the selected device from the list is asked to
show a local response. This can be a blinking light or flashing header, depending on the
specific hardware.

25.6 Assign IP Address
With the “Assign IP address” button, the selected device parameters and location may be
changed. This highly depends on the selected device type and needs a specific password
for that. It is primary used by service personnel.

25.7 Additional information
The ‘Info’ button shows additional information about the selected device (if available).

25.8 Use IP Scan
The program works independent from COMBIVIS, but is opened in COMBIVIS. Menu bar
"Tools“ → "IPScan“.



25 | IP Scan Tool KEB Automation KG

334 ma_mu_sw-cv68-20428970_en

Fig. 441: IPScan Tool

1 2 3

Fig. 442: Registration Use IPScan

1 Start network scan 2 Device blinks (see device manual)
3 Assign address - reserved for KEB

Service
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26 Energy Efficiency Tool
Every manufacturer of drive technology is obliged to submit an energy efficiency declara-
tion for their devices. With this plug-in the energy efficiency of different types of
COMBIVERT can be classified and documented. The plug-in calculates absolute and rel-
ative power losses at eight different load levels in accordance with EN 61800-9-2. Users
can also define up to 8 additional user-defined load points to determine the exact effi-
ciency of the COMBIVERT.

For all KEB devices, even those which are not listed in the tool, the declaration can be
obtained from the document database or from the KEB homepage (► www.keb.de) as
PDF (search for part number -> data sheets).

26.1 Function
This plug-in creates a PDF document for a specified KEB COMBIVERT. The KEB Config-
urator is the data base. Therefor only devices are offered which are parts of configurator.
The operating points refer to the torque-generating current and the rated frequency of the
motor. The losses are related to the rated apparent power of the COMBIVERT.
The energy efficiency tool can be opened directly from the configurator or as an editor in
the Navigator. Configurator:
From the configuration project, select a specific COMBIVERT and right-click on it to go to
the context menu. Then click on "Generate Energy Efficiency Declaration".

Fig. 443: Energy Efficiency Tool Generate Energy Efficiency Declaration

http://www.keb.de/
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Navigator:
In the Navigator, right-click the project node and navigate to the item "Add Object". Click
on the “Energy Efficiency Declaration” button to open the editor.

Fig. 444: Add energy efficiency tool object

Choose a name for the editor:
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Fig. 445: Energy efficiency editor name
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1

2

3

4

5

6
Fig. 446: Energy efficiency declaration 1

1 Activate the loss-time profile 2 Select device
3 Points for loss calculation 4 Custom load points
5 Losses of load points normative and

user-defined
6 Create document

Coming from the navigator, the COMBIVERT must be selected from the list. After open-
ing the window, the 1st device is displayed in the list. Select the correct COMBIVERT
based on the part number.

Fig. 447: Energy Efficiency Declaration selection
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In the default setting, the relative and absolute losses are displayed for the operating
points defined in EN 61800-9-2.

Fig. 448: Energy Efficiency Tool Normative Operating Points

In addition, the user can define up to 8 own load points. The loss values are interpolated
from the normative values. The points can be entered by a mouse double-click in the left-
hand graph or manually in the table "Custom load points".

Fig. 449: Energy Efficiency Tool Custom load points

The values are displayed graphically in the left field.
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26.2 Loss-time profile
This can be used to create a curve that shows the losses over an operating cycle. The
profile is activated by setting the check mark in the field "Loss-time options".

Fig. 450: Energy Efficiency Tool Loss-Time-Profile Options

The cycle time can be entered absolutely in seconds or relative.
The profile is generated exclusively from the "User-defined operating points" table.
To integrate normative load points, they can be dragged down from the "Normative oper-
ating points" table above. The time values must be entered manually.
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Fig. 451: Energy Efficiency Tool Loss-Time-Profile required

26.3 Generate declaration / data sheet
After defining the work points and optionally the loss-time profile, the user can create a
PDF report. The report contains all important device data, the normative and custom
defined loss values, and the loss-time profile (if selected).
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Fig. 452: Energy Efficiency Tool Data Sheet 1
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Fig. 453: Energy Efficiency Tool Data Sheet 2
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27 Parameter cockpit
The Parameter Cockpit is a tool to display parameter values in separate window and big-
ger size.
Parameter Cockpit can be opened on a project or a device.
When the cockpit is opened on the project, parameters of several units can be inserted. If
it is opened on a specific device, only from that device.

Open:
Open by menu bar icon “add object”:

Fig. 454: Parameter cockpit

Or in the navigator with right mouse click:
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Fig. 455: Add parameter cockpit object

Set a name:
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Fig. 456: Assign parameter cockpit name
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Fig. 457: Parameter Cockpit Display fields

The Parameter Cockpit includes 8 view boxes.

Parameters can be set by Drag&Drop from the device parameter editor or from a para-
meter list to one of the view boxes.

Fig. 458: Parameter Cockpit Drag and Drop
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The Parameter Cockpit is placed at the bottom of the editor window. It can be placed also
on other sides. (≡► Window layout [} 147])

Fig. 459: Parameter Cockpit Testrun

The Parameter Cockpit can be opened several times.
Parameters from several units can be placed together in a Parameter Cockpit if it is at-
tached to the project and not to a specific device.
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28 Additional modules / plug-ins
Further additional modules for COMBIVIS 6 and/or COMBIVIS studio 6 may be published
during the term of the version. These are integrated either via the update function or as a
separate installation. The description for the additional modules is published separately in
the KEB document database.
(≡► Document database [} 284])
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29 Help areas
29.1 Help for specific functions

By moving the mouse over the  sign, the corresponding help or explanation text is
briefly displayed.

Fig. 460: Help area parameterisation

29.2 Help for program functions
Pressing the F1 key in a particular program function jumps to the corresponding place in
the operating instructions.

Fig. 461: Help areas device editor
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➊

➍

➋
➌

Fig. 462: Help areas display modes

➊ Opens the integrated help ➍ Open manual for COMBIVIS 6 as
PDF

➋ Keyword overview ➌ Search function in the help

The help distinguishes between the function of COMBIVIS 6 and CODESYS program-
ming system.

Fig. 463: Help areas online help programming system

29.3 Help for specific device functions (FAQ)
(Formerly "HowTo" documents)
Descriptions or examples are available for certain device functions and procedures. Help"
menu bar → "Show FAQ documents".
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➊

Fig. 464: Help areas device editor

➊ View function descriptions and
sample lists

The document database with file type FAQ is opened. Depending on the programme or
device type, descriptions or sample parameter lists are displayed. Files can be opened
directly with a double click. Parameter lists can be assigned to a device and opened by
double-clicking.

Fig. 465: Help areas FAQ

29.4 Help for parameter functions
COMBIVIS 6 allows direct access to the device documentation. Requirement is that the
documentation was imported from the KEB website into COMBIVIS 6. The feature is
available only for registered COMBIVIS 6 or licensed COMBIVIS studio 6 versions.A PDF
viewer is required. The KEB PDF viewer is integrated in COMBIVIS. However, others can
also be used.
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When the corresponding Programmer's Guide is installed, with the function context menu
- "Find documentation ..." the declaration of the parameter will be shown.

➊
Fig. 466: Help areas parameter function

➊ Right mouse button on the para-
meter. Displays an explanation of
the parameter in KEB documents.

The programming manual of the device opens in the KEB PDF viewer.

Fig. 467: Help areas parameter function

In the right part of the window all digits are displayed where the selected parameter ap-
pears.The selection of a reference leads to a jump to the location in the PDF document.
The direct opening and import of the documentation is described in the following chapter
(≡► Document database [} 284]).

29.5 COMBIVIS error messages
COMBIVIS shows errors in message window or instead of the parameter value.

Value Name Source Description
-200 Exception error Driver (COMBIVIS in-

ternal)
Unexpected error in telegram processing
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-110 Service parameter in-
valid

Driver (COMBIVIS in-
ternal)

Invalid coding of the request

-109 Channel not available Driver (COMBIVIS in-
ternal)

Telegram could not be sent (e.g. interface not available)

-108 Channel occupied Driver (COMBIVIS in-
ternal)

The channel is occupied by another component

-107 BCC error Driver (COMBIVIS in-
ternal)

Transmission error (response from the device received in-
correctly)

-106 Protocol error Driver (COMBIVIS in-
ternal)

Invalid coding of the response telegram

-105 Service decoding un-
supported

Driver (COMBIVIS in-
ternal)

Invalid coding of the request

-104 Service encoding un-
supported

Driver (COMBIVIS in-
ternal)

Invalid coding of the request

-103 Node address invalid Driver (COMBIVIS in-
ternal) / Gateway

Invalid node address

-102 Invoke ID invalid Driver (COMBIVIS in-
ternal)

Invalid coding of the response telegram

-101 Invalid answer Driver (COMBIVIS in-
ternal)

Invalid coding of the response telegram

-100 Channel closed Driver (COMBIVIS in-
ternal)

The channel is closed / in parameter list:" wrong device ref-
erence

-10 No response Driver (COMBIVIS in-
ternal)

No response received within the timeout period

0 OK Target device OK

1 Device not ready Gateway
The target device is not accessible (error code is typically
reported by a gateway component, e.g. USB converter, op-
erator, port expander ...)

2 Address/password in-
valid

Target device / Gate-
way

Password level for access is not sufficient

3 Data invalid Target device Data is invalid (e.g. outside the range of values)
4 Parameter write-pro-

tected
Target device Parameter can only be read

5 BCC error Target device Transmission error (request received incorrectly by the
device)

6 Device busy Target device The device is accessible but busy (e.g. reset or similar) and
will be available again soon

7 Service not available Target device / Gate-
way

Service is not supported (can be reported by the device or
a gateway component)

8 Password invalid Target device / Gate-
way

Password level for access is not sufficient

9 Telegram error Target device / Gate-
way

Invalid coding of the telegram

10 Transmission error Target device / Gate-
way

Invalid coding of the telegram

11 Set/subindex invalid Target device / Gate-
way

Set (for service 0) / subindex (for service 14) not available
for this parameter

13 Address invalid Target device Invalid parameter address
14 Operation not pos-

sible
Target device / Gate-
way

Function (in the current state of the device) not possible.
e.g.: Control release is set
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29.5.1 Other error messages:
a) At starting of COMBVIS or COMBVIS studio an error message pops up: The file C:
\Programdata\COMBIVIS6\ COMBIVIS6ProjectDefaults.opt could not be loaded.

Fig. 468: Help areas error messages

The last time the project was saved, the "COMBIVIS6ProjectDefaults.opt" file was dam-
aged or is now empty. These .opt files save personal settings for language, window sizes,
etc. They have no influence on the content of the project. The files are created new each
time the project is saved. Therefore, the damaged file (only this one!) can be deleted:
The path is displayed in the error message. "Program Data" is a so-called "hidden" folder.
If it is not visible in Windows Explorer, you must make it visible in the folder options.

Windows 10:
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Fig. 469: Help areas view hidden files

Then restart COMBIVIS 6.
Reinstalling COMBIVIS will not help, because this folder is not deleted when uninstalling.

29.6 TeamViewer
You can access the KEB website for technical support via the "Service and support"
menu item. The "TeamViewer Quicksupport" software is available for download here.
"Help" menu → "Service and support"
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Fig. 470: Help - Call up the service and support page

TeamViewer is a programme with which a participant can access another PC via the In-
ternet, see its screen and operate it.
The computer with COMBIVIS must have a sufficiently fast internet connection.
The owner of the "watched" PC must explicitly start the programme and agree to the ac-
cess. Remote access is only possible with a licensed full version of the same or higher
version.
COMBIVIS TeamViewer cannot be used to access another PC. Access is not restricted to
COMBIVIS.

Start the program:

Agree to the disclaimer:
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Fig. 471: Help areas Disclaimer

Give the ID and password to the user of the PC to be connected:
Info! A new password is assigned each time the system is called up.
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Fig. 472: Help areas allow remote control

The connection status is displayed at the bottom. A recording of the session can be
made:

Fig. 473: Help Areas Confirm Access

The control and properties window is displayed:
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Fig. 474: Help areas TeamViewer

Click on the "X" to exit and close.
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30 Frequently asked questions (FAQ) about COMBIVIS 6

30.1 FAQ COMBIVIS 6 parameterisation environment

30.1.1 Can COMBIVIS 5 and COMBIVIS 6 be used simultaneously?
Both programs can be installed and opened at the same time. But each COM- and USB-
interface can be used only by one of them. (e.g., CV5 by COM1/serial and CV6 by USB-
COM6 will work).

30.1.2 Is it possible to use COMBIVIS 6 twice at the same time?
CV6 can be open several times at the same time. But each COM- and USB-interface can
be used only by one of them.

30.1.3 Is it possible to use parameter lists (.dw5), work lists (.wr5) and scope files (.sc5) of
COMBIVIS 5 at COMBIVIS 6?

With COMBIVIS 6 .dw5- and .wr5-files can be opened and saved. Scoped files "sc5" do
not.

30.1.4 Is it possible to parameterize older KEB drive controllers (e.g., F4) with CV6?
No, it is not intended.

30.1.5 After inserting a parameter list into the project, there is shown: “channel closed” in the
online values.

The device reference in the parameter list is not the same as in the actual device.
→ Adjust the device reference in the list.Or:Device is not connected.

30.1.6 Is it possible to open several projects with CV6 at the same time?
CV6 can handle only one project at the same time. But CV6 can be opened several times
with different projects (also in different languages).

30.1.7 Why will be found the same device several times by using the USB-Serial-Converter
Part No. 0058060-0020 / -0040?

By using USB serial converter at a HSP5 interface of F5/B6, a device is found at each
searched node address, since at HSP5 the node addresses are not specified (always
only 1 node at HSP5). The USB serial converter converts the HSP5 protocol to
DIN66019, and there the node addresses are queried. Solution: Search only at one node
address. Or at manually searching, mark and open only one device.

30.1.8 By using USB serial converter at a HSP5 interface of F5/B6, the drive controller will be
not or only by searching several times found.

In default of COMBIVIS 6 with connected USB serial converter the searching procedure
starts with 9600 baud and counts upwardly afterwards. Since HSP5 always works with
38400 baud, the USB serial converter must first count up the baud rate. → Preset the
baud rate at the corresponding interface to 38400 baud, by way the drive controller is
then reliably found.
Note: When using the USB serial converter at a serial interface DIN66019, another baud
rate may also be correct (default F5: 9600 baud).
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30.1.9 When changing a parameter value, the property editor window is not shown. Or:
Parameter values cannot be entered/changed.

Please try to open the property editor window in the toolbar menu “view”. Afterwards
search at the screen frame to see if the property editor window is not collapsed. If found,
click into the property editor window, and open it.
Clicking on the pin symbol fixes the window size.
Also possible: "Menu“ → "Window“ → "Reset Window Layout“.

Fig. 475: FAQ Property Editor

30.1.10 The copy function Fr01 at COMBIVERT F5/B6/G6 seems not to work.
With the parameter set copy function Fr01 at COMBIVERT F5/B6/G6 finished sets can be
copied to other sets and then does not have to enter all the parameters again. The copy
function runs in the drive controller and is triggered by COMBIVIS by entering the para-
meter Fr01 only.
Because of the parameter "copy function" is set programmable, the set addressing mode
plays an essential role in the process.
When copying the "collapsed" parameter the direct addressed set is the target (usually
are then target and source set equal to 0):
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Fig. 476: FAQ Copy function

Solution: Please adjust in column “set” the number of the set which is the target of the
copying and adjust in the column “Offline/Online value” the number of the set which is to
copy.

30.1.11 When creating a new project, the location is displayed as C:\user\... However, there is
no file with this name in the Windows 7 workstation.

With Windows 7, the file names given by the system are handled in English. In the "work-
space", the original names ("user") are then overlaid with the translated text ("user").
However, COMBIVIS (and most other programmes) can only access the original name
("user"). This even goes so far that you can create the file name "user" again, since the
other file is originally called "user".Solution: "User" = "user" or "programs" = "programs"
etc.

30.1.12 In editor is shown “service not available” at every parameter value“.
When operating with bus systems in "synchronous operation" only indirect addressing
may be used.
(≡► Set addressing [} 113])

30.2 FAQ Scope

30.2.1 Is it possible to record more than 16 channels?
Each scope can handle max. 16 channels, but Scope can be opened several times in a
project, each with 16 different channels. However, the fast scope mode only works on 4
channels per device.

30.2.2 Is it possible to save a COMBIVIS 6-scope recording in COMBIVIS 5 (sc5) format?
No, because of different and upgraded structures it is not possible.
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30.2.3 Is it possible to merge channels from different scope recordings?
This is planned for a later COMBIVIS 6 version. Currently it is already possible, but only
indirectly via export in an Excel-compatible format. Export the scope as a CSV file. In Ex-
cel it is possible to merge curves as tables based on time-axis and compare them directly
via diagram function.

30.2.4 The externally stored Scope file ending sc6 cannot be opened.
With COMBIVIS 6 versions up to 6.2.2.0 only XML files can be imported!
The .sc6 data format continues to be an XML format. A file extension .sc6 can be re-
named to XML and thus imported into earlier COMBIVIS 6 versions.

30.3 Known problems

30.3.1 Scope - horizontal cursors
The horizontal cursors in Scope locks only on the values of the first channel. The meas-
ured values of the other channels cannot be read. 

Workaround:
By "Scope → Settings → Extended“: disable the hook at “Cursors snap to values”. Within
the cursors can be placed freely by mouse.
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Fig. 477: Scope Settings

30.3.2 Windows - Decimal point
At German Windows operating system and setting in English, the COMBIVERT G6/F6
ASCL/SCL wizard has problems if the comma is used to separate the decimal place.
Workaround:
If a value with decimal place is entered, the usual dot in English must be used. A
comma will be ignored! In the display, however, "by default" can be a comma and then
also applies. The parameter editor can use either a dot or a comma, both are valid.
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Fig. 478: Motor identification

30.3.3 Error message on startup
At starting of COMBVIS or COMBVIS studio an error message pops up: The file C:\Pro-
gramdata\COMBIVIS6\ COMBIVIS6ProjectDefaults.opt could not be loaded.
Workaround:
Delete the file in Windows Explorer. Restart the programme.
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Fig. 479: Error message on startup
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Glossary

CODESYS
CODESYS® is a manufacturer-independent auto-
mation software for project planning of control sys-
tems. CODESYS is a registered trademark of
CODESYS Development GmbH.

COMBIVIS
KEB start-up and parameterizing software.

IEC 62061
Safety of machinery - Functional safety of safety-
related control systems.

ISO 13849-1
Safety of machinery - Safety-related parts of con-
trol systems - Part 1: General principles for
design.

SCADA
SCADA stands for Supervisory Control and Data
Acquisition and describes the basic functions of a
SCADA system. Companies use SCADA to con-
trol their systems across sites and to collect and
record data about their operation.
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